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Davallia Technology Software License Agreement 

READ THE TERMS AND CONDITIONS OF THIS 
LICENSE AGREEMENT CAREFULLY BEFORE 
OPENING THE PACKAGE CONTAINING THE 
PROGRAM CDROM, THE COMPUTER SOFTWARE 
THEREIN, AND THE ACCOMPANYING USER 
DOCUMENTATION (THE “PROGRAM“). THE PROGRAM 
IS COPYRIGHTED AND LICENSED (NOT SOLD). BY 
OPENING THE PACKAGE CONTAINING THE 
PROGRAM, YOU ARE ACCEPTING AND AGREEING TO 
THE TERMS OF THIS LICENSE AGREEMENT. IF YOU 
ARE NOT WILLING TO BE BOUND BY THE TERMS OF 
THIS LICENSE AGREEMENT, YOU SHOULD 
PROMPTLY RETURN THE PACKAGE IN UNOPENED 
FORM, AND YOU WILL RECEIVE A REFUND OF YOUR 
MONEY. THIS LICENSE AGREEMENT REPRESENTS 
THE ENTIRE AGREEMENT CONCERNING THE 
PROGRAM BETWEEN YOU AND DAVALLIA 
TECHNOLOGY (REFERRED TO AS “LICENSOR”), AND 
IT SUPERCEDES ANY PRIOR PROPOSAL, 
REPRESENTATION, OR UNDERSTANDING BETWEEN 
THE PARTIES. 

1. License Grant. Licensor hereby grants you and you 
accept, a nonexclusive license to use the Program 
Diskettes and the computer programs contained therein in 
machine-readable, object code form only (collectively 
referred to as the “Software”), and the accompanying User 
Documentation, only as authorized in this License 
Agreement. The Software may be used only on a single 
computer owned, leased, or otherwise controlled by you; or 
in the event of the in-probability of that computer, on a 
backup computer selected by you. Neither concurrent use 
on two or more computers nor use in a local area network 
or other network is permitted without separate 
authorization and the payment of other license fees. You 
agree that you will not assign, sublicense, transfer, pledge, 
lease, rent, or share your rights under this License 
Agreement. You agree that you may not reverse assemble, 
reverse compile, or to otherwise translate the Software.  

Upon loading the Software into your computer, you may 
retain the Program Diskettes for backup purposes. In 
addition, you may make one copy of the Software on a 
second set of diskettes (or on cassette tape) for the 
purpose of backup in the event the Program Diskettes are 
damaged or destroyed. You may make one copy of the 
User’s Manual for backup purposes. Any such copies of 
the Software or the User’s Manual shall include Licensor’s 
copyright and other proprietary notices. Except as 
authorized under this paragraph, no copies of the Program 
or any portions thereof may be made by you or any person 
under your authority or control.  

2. Licensor’s Rights . You acknowledge and agree that 
the Software and the User’s Manual are proprietary 
products of Licensor protected under Australian copyright 
law. You further acknowledge and agree that all right, title, 
and interest in and to the Program, including associated 
intellectual property rights, is and shall remain with 
Licensor. This License Agreement does not convey to you 
an interest in or to the Program, but only a limited right of 
use revocable in accordance with the terms of this License 
Agreement.  

3. License Fees. The license fees paid by you are paid in 
consideration of the licenses granted under this License 
Agreement.  

4. Term: This License Agreement is effective upon your 
opening of this package and shall continue until 
terminated. You may terminate this License Agreement at 
any time by returning the Program and all copies thereof 
and extracts therefrom to Licensor. Licensor may terminate 

this License Agreement upon the breach by you of any 
term hereof. Upon such termination by Licensor, you agree 
to return to Licensor the Program and all copies and 
portions thereof.  

5. Limited Warranty. Licensor warrants, for your benefit 
alone, for a period of 60 days from the date of 
commencement of this License Agreement (referred to as 
the “Warranty Period”) that the Program Diskettes in which 
the Software is contained are free from defects in material 
and workmanship. Licensor further warrants, for your 
benefit alone, that during the Warranty Period the Program 
shall operate substantially in accordance with the 
functional specifications in the User’s Manual. If during the 
Warranty Period, a defect in the Program appears, you 
may return the Program to Licensor for either replacement 
or, if so elected by Licensor, refund of amounts paid by you 
under this License Agreement. You agree that the 
foregoing constitutes your sole and exclusive remedy for 
breach by Licensor of any warranties made under this 
Agreement. EXCEPT FOR THE WARRANTIES SET 
FORTH ABOVE, THE PROGRAM, AND THE SOFTWARE 
CONTAINED THEREIN, ARE LICENSED “AS IS,” AND 
LICENSOR DISCLAIMS ANY AND ALL OTHER 
WARRANTIES, WHETHER EXPRESS OR IMPLIED, 
INCLUDING WITHOUT LIMITATION, ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE.  

6. Limitation of Liability . Licensor’s cumulative liability to 
you or any other party for any loss or DAMAGES resulting 
from any claims, demands, or actions arising out of or 
relating to this Agreement shall not exceed the license fee 
paid to Licensor for the use of the Program. In no event 
shall Licensor be liable for any indirect, incidental, 
consequential, special, or exemplary damages or lost 
profits, even if Licensor HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. SOME STATES DO 
NOT ALLOW THE LIMITATION OR EXCLUSION OF 
LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE LIMITATION OR 
EXCLUSION MAY NOT APPLY TO YOU.  

7. Trademark. SmartRoster is a trademark of Licensor. No 
right, license, or interest to such trademark is granted 
hereunder, and you agree that no such right, license or 
interest shall be asserted by you with respect to such 
trademark.  

8. Governing Law. This License Agreement shall be 
construed and governed in accordance with the laws of the 
State of Western Australia.  

9. Cost of Litigation. If any action is brought by either 
party to this License Agreement against the other party 
regarding the subject matter hereof, the prevailing party 
shall be entitled to recover, in addition to any other relief 
granted, reasonable attorney fees and expenses of 
litigation.  

10. Severability. Should any term of this License 
Agreement be declared void or unenforceable by any court 
of competent jurisdiction, such declaration shall have no 
effect on the remaining terms hereof.  

11. No Waiver. The failure of either party to enforce any 
rights granted hereunder or to take action against the other 
party in the event of any breach hereunder shall not be 
deemed a waiver by that party as to subsequent 
enforcement of rights or subsequent actions in the event of 
future breaches.
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best possible schedule for your small or 

large organization. SmartRoster  

handles the scheduling tasks that you 
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Welcome to SmartRoster 
Scheduling is a difficult, complex, and ever-changing task. You spend many 
hours assigning individuals to roles and dates, and just when you think you have 
it right, you spot someone who is scheduled to play keyboard and work the 
overhead projector on the same day. This is just one of any number of situations 
that might force you to go through the whole process again. And the more 
people, roles, and meetings you have, the more complex it gets. Fortunately, 
SmartRoster makes your scheduling process both easy and efficient. Rather than 
wading through personal information like routine absences, role requirements, 
household and group requirements, personal associations, and trying to create a 
schedule that works for everyone, you can now just let SmartRoster do the work 
for you. 

SmartRoster Limits 

Registered users 

For registered users there are no limits on the number of schedules, events, 
roles, or people you can enter, apart from your hardware limits (such as the 
amount of memory in your computer), or license limit (for number of people you 
can store in the program).  

Un-registered users 

SmartRoster will cease to operate 30 days after first installation and must be 
registered if you wish to continue using it. 

 

Feature Unregistered  Registered  
Maximum number of People  Unlimited1 Dependent on your 

licence conditions 
Number of Households Unlimited Unlimited 
Number of Groups Unlimited Unlimited 
Number of Events Unlimited Unlimited 
Number of Roles Unlimited Unlimited 
Duration of license 30 days Unlimited 

 

What Can SmartRoster Do? 
SmartRoster has many powerful features to help you manage your people, 
repeating events, and schedules. SmartRoster handles the scheduling tasks that 
you once had to do manually.  SmartRoster: 

o Stores important data on your organization, personnel, schedules, roles and 
events, 

o Handles personnel with specific associations by allowing you to set up 
detailed constraints that are followed when the Automatic Scheduler fills 
your schedule. 

                                                      
1 Unlimited in this page means limited by the computer’s hardware memory capacity only  
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o Lets you set up a person’s timeline to specify dates when the person is not 
available, and to do the same for whole households at a time, as well as 
groups of people; 

o If you choose, you can manually fill schedules, by selecting the individuals 
from the People or Role panels; 

o Lets you easily modify your schedule to accommodate last-minute changes; 

o Allows for special one-off events (such as a midweek Missionary meeting) 
with their own specific personnel requirements; 

o Enforces specific individual usage targets (such as once a month, or every 
2nd week); 

o Automatically evens out usage of people on schedules, while still satisfying 
individual associations (for individuals where specific targets are not set); 

o Allows specification of various constraints, such as: known absences, 
patterns of absence (e.g., to suit fly-in fly-out workers), matching people to 
roles, role-role compatibility, households or friends that prefer to be, or not 
to be, scheduled on the same day; 

o Automatically fills your schedule with a single click, matching role 
requirements to personnel availability and skills, and factoring in personal 
associations; 

o Allows for multiple events (e.g. Services) per day; 

o Prints master schedule (selected roles on one page) or individualized 
schedules (showing only the recipient’s roles), for individuals, or households, 
with names pre-highlighted; 

o Generates a booklet-style address book; 

o Generates read-only and print-ready electronic version of any report, ready 
to be emailed to recipients, who use the supplied SmartRoster Viewer (which 
comes with this program, free to distribute) or Acrobat Reader; 

o Automatic email reminders; 

o Import/Export existing personnel data in comma/tab delimited format from 
your existing personnel database (eg Church Management System); 

o Easy-to-use drag and drop style MS Windows Interface; 

o Very modest hardware requirements – runs fine on any PC running Windows 
98 or higher (see System Requirements, page 25). 
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SmartRoster Basics 
Whether you're comfortable with computers, or a complete beginner, this is 
where you should start. This manual will tell you everything you need to know to 
start using SmartRoster. Before you start, make sure that you understand some 
of these basic terms and concepts. 

o Windows Terms 

o SmartRoster Terms 

o SmartRoster Panels 

o Exiting SmartRoster 

Windows Terms 

Clicking 
When we refer to clicking, we mean that you place the mouse pointer over that 
section of the screen (by moving the mouse) and press the left mouse button 
once. 

Double clicking 
When we refer to double clicking, we mean that you place the mouse pointer 
over an item on the screen and quickly press the left mouse button twice. 

Right clicking 
When we refer to right clicking on something, we mean that you place the 
mouse pointer over an item on the screen and press the right mouse button 
once. 

Drag & Drop 
To Drag & Drop, move your mouse over the object, click the left mouse button 
and hold it down while moving the mouse elsewhere. Then, once you have 
positioned the mouse where you wish to put the object, release the left mouse 
button.  

For example, to add a person, drag & drop the person from the People panel (at 
the left) to the Role Members area by doing the following: 

1. If the People panel is not visible to the left of the main window, open it by 
selecting View People from the View menu on the menu bar. 

2. Make sure at least one role exists and that the Role panel is visible (in the 
same way as you made sure the People panel was visible). 

3. Select a person from the list of available people on the People panel. Keep 
holding down the left mouse button and move your mouse cursor to the 
white Role Members list area in the upper right of the screen. 

4. Release the left mouse button. A person is now added to the Role Members 
list. 



SMARTROSTER BASICS  
  

 

   11 
 

Checkboxes (or Tickboxes) 
When we refer to selecting or ticking  an option, we mean that you should click 
on the checkbox, so that a tick mark appears in the checkbox like this:  
When we refer to de-selecting or clearing an option or checkbox, we mean that 
you should click on the checkbox, so that the checkbox is cleared, and appears 
like this:      

Option button 
When we refer to clicking on this option or selecting this option, we mean that 
you should click on the Option button, if necessary, so that it appears like this: 

Drop-down list 
When we refer to selecting from a drop-down list, we mean that you should click 
on the down arrow to the right of the box, which displays the drop-down list and 
then you should click on one of the choices to select that choice. 

Menu bar 
The Menu bar is the top section of the SmartRoster screen that lists the program 
function groups - File, View, Events, People, Role, Schedule, Report and Help.  

See Using SmartRoster’s menus on page 116 for further details. 

 

In this manual, terms like “…select the File > New  menu….” mean that we are 
asking you to click on the first word (in this case File) on the menu bar followed 
by the second word (in this case New) in the drop down menu. 

 

Tool bar 
The Toolbar is the area just below the Menu bar. It contains several pictures, 
each of which activates a different area of the program when clicked. All these 
items correspond to menu choices that are available on the main menu bar.  

 

See The SmartRoster Toolbar on page 119 for details. 

 

Check List box 
The Check List Box is a list box that contains a tick box 
on the left of each item in the list. You can click the tick 
box next to an item to make the item active (if ticked) or 
inactive (if unticked). The meaning of active/inactive will 
depend on the context, but is usually self-evident.  

In some cases right-clicking on a Check List Box will activate further choices. 
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SmartRoster Terms 
 

Automatic  The Automatic Scheduler is the program that actually fills the schedule once you 

have defined all the constraints and entered the information it requires. It is 
accessed by clicking Auto Fill  on the Tool bar, or selecting menu Schedules > 
AutoFill . 

Using the Automatic Scheduler does not prevent you from manually allocating parts or all of 
certain schedules yourself. It is likely you will need to do that at least for some roles. Keep in 
mind, however, the more manual allocations to the schedule you make, the less benefit you 
will obtain from using the Automatic Scheduler, and the more likely it is that you will introduce 
errors that the Automatic Scheduler is designed to prevent. The Automatic Scheduler uses 
proprietary technology to obtain the best possible schedule given the set of associations, 
usage targets, etc. It is very unlikely you will be able to manually match its output by manually 
allocating all positions, without taking a very long time! 

 

Event  SmartRoster uses the word Event to mean a series of meetings (which could 

be a single meeting, a set of discrete dates, or a pattern – eg weekly – of 
meetings), where each meeting in the series requires the same roles and the 
same number of individuals on each role. If a specific meeting requires different 
roles, or a different number of people in any role, then you need to define a 
separate Event for that meeting. In summary, an event is a unique pattern of 
Times and Roles with a unique set of role requirements. 

 

Role  A Role is an activity required by an event (e.g. keyboard player, overhead 

projectionist). Individuals can be assigned to one or more roles. When assigned 
to a role, the individual can be nominated a desired usage (such as once a week, 
twice a month, or 7 times a year). If not so nominated, the Automatic Scheduler 
will attempt to schedule role members as evenly as possible. 

 
Person  “Person” refers to any individual who is to be scheduled. What applies to a 

person also usually applies to households and groups. You can apply constraints 
directly to households and groups, which then affect each person in the 
household or group. 

 

Constraint 
 The Automatic Scheduler forms the schedule based on the constraints that you 

will enter, specifying necessary and desirable relationships 

o between persons (or households or groups) (called Association preference) 

o between roles (called Role compatibility) 

o between roles and persons[, households or groups] 

o between events and roles 

o between events and persons[, households or groups]  

 

 

Schedule  For each role a schedule will be generated (manually or automatically) which 

indicates who (person, household or group) will fill what role, and when. The 
schedule will be generated for each event date/time for which the corresponding 
role is required. 

 

Scheduler  
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The Events Panel – 
is where you define 
the sorts of events 
your Church or 
club needs 
schedules for, 
including the dates 
on which these 
events occur, and 
also the roles these 
events require to be 
scheduled. See page 
42 for details 

The People panel – is 
the main area for 
managing persons, 
households, and groups 
and always displays 
along the left hand 
edge. It will show 
Individuals, 
Households, or Groups 
depending on which 
option is selected from 
the People menu. This 
panel allows you to add 
people, households, or 
groups (more on that 
later), edit existing 
ones, or to remove 
them. See page 28 for 
details. 

SmartRoster Panels 
All panels have some aspects in common.  
They all have a title bar like that shown at right:  

The down arrow  indicates a menu is available by 
clicking either on the arrow or the above text. Clicking 
on the X will close that panel. To reactivate a closed 
panel, you will need to select the appropriate option from the View menu, or 
chose the appropriate tool bar icon.  

You can re-size the panels by clicking between panels. Move the mouse pointer 
over the region between panels. When the mouse pointer looks like     hold the 
left mouse button down and move it to resize the panels on either side. 

The SmartRoster screen has four different Panels –  
• People (this panel shows Individuals, Households, Groups and Comments),  
• Events, 
• Roles, and  
• Schedules.  

Each of the panels allows you to manage the objects you see inside that panel. 
 

 

 

The Roles panel – is where you define the roles. Roles correspond to 
specific skill sets to which individuals are allocated. You can simply 
drag names from the People panel into the Role Members list of 
those who are able and available to fulfil that role. For each role a 
separate column will be generated in the Schedules panel (as long as 
Include on Schedule is ticked). See page 40 for details 

The Schedules panel – Here you construct the final schedule for each role specified in 
the Roles panel. You can do this completely manually by dragging names from the role 
participants list or directly from the People panel; you can get SmartRoster to do it for 
you completely automatically (obeying all constraints you have defined) or (and this is 
most likely) you can set up part of the schedules manually and get SmartRoster to 
finish it off for you. See chapter 5, page 46, for details 

Click and drag 
anywhere on the  
borders to re-size 
the panels 

Use these tool 
bar buttons to 
alternately hide 
or show any of 
these panels 
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The People  Panel  

The People panel is the area in which you manage 
your lists of people, households, and or groups of 
individuals or households. This panel presents a 
tabbed list similar to a telephone teledex. You 
select tabs by merely clicking on the 
tab you wish to display.  

You can change the tabs to display 
three letters at a time (e.g. ABC), to 
display households, or to have no 
tabs at all. To do this either click on 
the drop arrow under People, or 
right-click on top of the actual list. 
You will see the following menu.  
Select Display as…  to change the 
way the tabs display. 

The People panel can display 
Individuals, Households, 
Groups, or Comments. Just select 
the appropriate button. 

As you can see, items are listed in alphabetical order. To edit an item double-
click on that item. To add a new item, select New from the menu. To remove an 
item, first select the item, then right-click and select Remove  from the menu. 

The check box to the immediate left of individual names can be used to activate 
or deactivate those persons, households or groups globally. When a person is 
inactive, that person will never be automatically assigned to any schedule, even 
if they belong to a role that is being scheduled. While inactive, that person (or 
household or group) will be ignored by the Auto Scheduler. If it is a household or 
group, then the Auto Scheduler will ignore every person belonging to that 
household or group. 

The Find : box allows you to narrow down the list by entering the a few 

characters of the first or last name. The panel will display only those names that 
conain the search string in this box. 

Advanced Filter button:  Click this button to create an advanced filter. This 
allows you to restrict the people visible in the People panel. The query allows you 
to select or nominate values or partial values for any of the attributes such as 
name, address, telephone, email, notes, events, roles, groups. See also page 90 
on how to create and use advanced filters. 

See chapter 3 for details on managing people. 
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The Events  Panel 

 

This panel lists all currently defined events. Events are a short cut for a pattern 
of date-times and a list of valid roles. The Event name will appear on printed 
schedules, as well as in the Schedules panel (below). Once again, you can 
activate or deactivate an event by ticking the check box. An inactive event will 
NOT appear in the Schedules panel, and the Automatic Scheduler will not 
attempt to schedule any role to that event. 

To edit an event definition, double-click on the event name. To add a new event, 
click on “Events” and select New from the menu. To delete an event, select 
Remove  from the menu. You can select multiple events to remove by holding 

down the shift or control keys while selecting events. 

See chapter 4 for details on setting up Events 

What is an 
Event?   
See page 12  
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The Roles  Panel 

This panel is where you will set up each role for which you wish to create a 
schedule. It is organised as a tabbed display, one tab for each role. Within each 
role tab, you can further select information about the role by clicking one of the 
subordinate tabs “General”, “Members”, or “Notes”. To assign people to a role 
(these are called Role Members), you can drag & drop each person individually 
from the People panel (the People panel must be visible) or use the context 
menu (right-click over the Members list) an select New. Only those Role 
members will show who are available for the events that are active (ticked) in 
the Events panel unless “Show all members” is selected from the context menu. 

See chapter 4 for details on setting up Roles.

When you assign a person to 
the role, they appear in the 
Role Members list. You can 
also activate or deactivate 
them by ticking the check box 
in this window 

A person may be required, or desire, to 
perform in their role with a certain 
maximum frequency. Double click on a 
person here to set their Usage Target. This 
then sets the target for the Automatic 
Scheduler when attempting to fill the 
schedule for this role. 

If there is a specific 
person with overall 
oversight of a 
specific role, drag 
their name into the 
Contact edit box. 
Their name will 
appear in the 
schedule for that 
role 

By default, if a person is scheduled during 
an event (service) to a given role, they 
cannot be scheduled onto another role (they 
are incompatible). By adding roles into the 
Compatible Roles list, you can allow for 
people to be scheduled to multiple roles for 
the same event. 

By default, a new role 
is required by ALL 
EVENTS (i.e. will be 
required on all dates 
that all events 
require). By dragging 
events from the Events 
panel into the list box, 
Applies to Events,  
you can restrict the 
events to which this 
role applies 

Deselecting Schedule this role  
allows you to temporarily prevent 
a specific role from being included 
in the Schedules panel (and 
therefore being scheduled by the 
Automatic Scheduler) 

Double click on 
any event to edit 
any of these 
properties 

The Roles menu 
can be accessed 
by clicking here 

What is a 
Role?   
See page 12 

Select the tab 
“General”, 
“Members”, or 
“Notes” to select 
which aspects of a 
role you wish to view 
and/or change 

Right click anywhere over the Role 
Members list to select either List view or 
Detail view (shown above) and whether 
or not to show the usage information 
(columns Target, Used, Hours) 

Select “Display As” from the “Roles” menu to display roles 
as Tabs or in a list box (as shown above) 
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The Schedules  Panel 

Finally, we meet the intended outcome of all our hard work, the Schedules panel. 
Here we interact with the schedules themselves. We do so to: 

o View the results of the Automatic Scheduler 

o Manually add or remove people on the schedule – You can manually add a 
person by:  
> dragging them from the Role Member list box onto the Schedules grid (in default grid format) 
> dragging them around within the grid itself (from cell to cell) (in default grid format) 
> dragging them from the People panel directly onto the grid (in default grid format) 
> right-click in any cell and select from the pop-up menu 

o Check for errors, omissions, or other inconsistencies 

o Lock or freeze rows, columns, or specific cells to prevent the Automatic 
Scheduler from changing your manual input. To lock a column, click the top 
left corner of the top cell of that column. To lock a row, click the top left 
corner of the left-most cell of the row. To lock an individual into a location, 
click just to the left of the person's name. 

See chapter 5 for details on creating and using Schedules. 

 
 

 
Set the current period for 
which you want to build a 
schedule by clicking on the 
down arrow. 

Each role 
appears as a 
column in the 
Schedules grid 

These numbers are a 
measure of how good 
the current schedules 
are (how well they 
meet Options and 
usage targets) 

Events are 
defined as a 
pattern or list of 
dates. This row 
corresponds to 
one event from 
that list. This 
cell tells you 
what date and 
time it is and the 
Event that it 
belongs to 

This lock symbol 
indicates that this 
whole row is locked 
and will not be 
overridden by the 
Automatic 
Scheduler. Notice 
that all the words 
the row appear in 
grey. 

This lock symbol 
indicates that 
Abraham is locked 
into this location and 
will not be overridden 
by the Automatic 
Scheduler. The name 
appears in grey, 
indicating it is locked 

The scroll bars allow you 
to view parts of the 
Schedules panel that are 
not currently in view 

Clicking here can 
access the 
Schedules menu 

This lock symbol 
indicates that this 
whole column is 
locked and will not 
be overridden by 
the Automatic 
Scheduler 

As you move the mouse 
pointer over names in the 
Schedules panel, the 
name currently under the 
pointer is highlighted in 
yellow everywhere it 
appears on the schedule. 

The red  indicates 
that this person has an 
attendance flag 
attached. You can 
define and attach 
your own attendance 
flags and then create 
a report bases on who 
has what flags 
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Alternate “Schedules panel” format 

The alternate grid format has individuals as rows and the event dates as 
columns. It shows roles (using role abbreviation if supplied) as values in the grid 
cells.  

This format is especially useful where a majority of individuals are scheduled 
many times within the schedule period. It it not as useful where you have a large 
number of people who are scheduled infrequently. 

To select this format, choose menu Schedules > Grid format and select 
“Dates by Names” from the menu. Choose “Dates” to go back to the default 
format. 

 

“Schedules panel” Date and Name format 

You can specify the format of the names or dates that appear on either axis by 
choosing the  Schedules > Name format or Schedules > Date format 
menu respectively. 

By selecting Date format you can specify how SmartRoster displays the 
Event/Date/Time label. This string can contain: 

<EVENT>   A literal token that is replaced by the event name 

<COMMENT> A literal token that is replaced by the event comment, if it exists for this 
event occurrence 

| A single "pipe" character which indicate a new line at this place in the 
event specifier 

Format string Strings of characters that substitute for date and time values.   
See: Date-time format strings on page 120. 
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Running Smartroster 
You can run SmartRoster by selecting it from the start menu. 

SmartRoster also offers a number of command line options for customising the 
default behaviour. 

Command Line Options 

To use command line options, you can edit the properties of the shortcut used to 
start SmartRoster by right-clicking on the shortcut in explorer and selection 
"Properties". 

The Target should look something like this: 

"C:\Program files\Davallia technology\Smartroster\smartros.exe" /FLAG1 /FLAG2 … 

/FLAG options, also called switches (because they turn options on or off), can 
include the following.. 

 

Command line switch Meaning 

/READONLY Any file opened in this session of SmartRoster 
cannot be changed. Save and Save As are disabled 

/OPEN "{FILENAME}" Starts SmartRoster and automatically opens the 
file named {FILENAME}. {FILENAME} (without 
the cirly brackets) is a fully qualified filename, 
like  

"c:\documents and settings\john\documents\ myfile.ros"  

This is effectively the same as if the user had 
opened the file via the file > open menu 

/LOCK Prevents the user from using the New, Open, 
SaveAs, Open from web, or Save to Web menus. 
They can only view and save the file passed in 
via an "/OPEN {filename}" switch. They can 
make changes to this file unless the /READONLY 
switch is also specified. 

/IMPORT "{FILENAME}" This automatically imports the file specified on 
the command line – either into the file opened 
via the /OPEN switch or into a new empty file. 
The file imported should be a recognised .CSV or 
.ros format 
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Exiting SmartRoster 
You can exit SmartRoster in one of two ways: 

o Select the File > Exit  menu, 

o Click on the Close button on the top right of the 

SmartRoster screen (the X). 

Backup Reminder 

When you close SmartRoster, you may be asked if you want to backup your 
SmartRoster file. As with all programs dealing with volatile data (ie data that 
change often), it is highly recommended that you regularly backup your 
SmartRoster file. 

 

 

 

When you see this dialog, accept or change the filename showing in the  
"Back up file to:"  box and click the Yes button.  

Click the No button if you do not want to back up your file at that time. 

If you do not want to be reminded, remove the tick from the Remind to back 
up on close  check box. You can always re-start backup reminders by selecting 
the File  > Options  menu. 
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File Sharing 

File sharing on a LAN 

To enable file sharing, tick the 
"Enable file sharing protocol" check box which is located under the File | Options  
menu and the Open & Save  tab. 

Once file sharing is active, SmartRoster controls who may have "read-write" 
access to a SmartRoster file.  

The first person to open the file will automatically be granted "read-write" access 
to the file. While the file is still open by that user, any subsequent user 
attempting to open the file will be granted "read-only" access and will not be 
able to over-write that file (although they will be able to “Save As” any changes 
they make to another file). They will know this is the case because the words 
"READONLY" will be appended to the filename in the SmartRoster title-bar . 

When the original user closes the file, the next least recent user to open the file 
will be informed that they can have "read-write" access to the file if they re-load 
it (to pick up any changes made by the original user). If they accept then they 
will then have full "read-write" access. If they decline, then "read-write" access 
will be offered to the next least recent user to open the file, until someone 
accepts "read-write" access or no one is left.  

SmartRoster WebShare  

File sharing over the internet! 

To enable file sharing over the Internet you need to , tick the "� Enable 

WebShare for file sharing over the internet" check box which is located under the 
File | Options  menu and the WebShare  tab. This will only be available if you have 
purchased at least two licenses. Annual support must be current to the Amazon 
S3 service (you can use your own FTP server without having current support). 

When you activate WebShare you need to set up the various options. These are: 

• Read only on this workstation 
If this is ticked then the workstation may be used to open shared SmartRoster files 
from the web but cannot save them back to the web. 

• Local Folder 

This is a location on your local PC that SmartRoster can use to facilitate uploading and 
downloading of shared files. 

• Contact Name, Contact phone, Contact email 
It is important that if you are to participate in sharing SmartRoster files that other 
users can contact you. You will not be able to save to the web or open web files for 
update until these details are provided 

• � Use my own WebShare server 

If ticked then this option allows you to define and use any web server you like, instead 
of our own Webshare server. You will need to obtain from your web server provider 
the details for connecting to it using FTP.   These items are required: 
- Web address:  this is your FTP server name 
- User ID:  your FTP user ID  
- Password: your FTP user Password 
- Port:  this defaults to 21 but you can specify any port to use 
- Initial path: this is the actual folder on your FTP server into which WebShare will  
   save SmartRoster files  
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Once file sharing is active you will be able to open and save SmartRoster 
documents from either our high performance web servers or from your own web 
server – such as from your internet service provider. 
 

WebShare functions 

WebShare functions are accessed via the File menu. 

File > Open from web… 

This will open a WebShare connection and list all current SmartRoster files that 
have been placed into WebShare (for your organisation).  

 

If a file is opened by someone else the details will be shown. You can open any 
file by clicking on it, and selecting Update or Read-only then clicking OK. This 
will download a copy to you local WebShare folder and open it up in 
SmartRoster. If you selected “Update” then SmartRoster will also flag that the 
file is opened by you for updating and no-one else will be able to open it for 
update until you release the file (by closing it or quiting SmartRoster). Once you 
have the file open for Update then every time your save using File > Save the 
file will be automatically re-uploaded to the WebShare server. 

If you selected “Read-only”, or the file was already opened by someone else for 
update, then the words "READONLY" will be appended to the filename in the 
SmartRoster title-bar. You will also know you are looking at a WebShare file 
because [WebShare] will appear in the titlebar just before the filename. 

File > Save to web… 

This will open a WebShare connection and list all current SmartRoster files that 
have been placed into WebShare (for your organisation). You can then select 
one of those files or enter in a new filename in the File name box to save the file 
to. Of course you cannot save to a file already open for update by another user. 
After saving the file you will automatically have update access until you close the 
file or close SmartRoster. 

Note:  “My Contact Details” are required to open or save a SmartRoster file to 
WebShare, except for opening in Read-only mode. Only those who have 
SmartRoster installed with the your registration details will have access to your 
SmartRoster WebShare folder, unless you use your own WebShare server and 
give your server logon details to someone else.  

File > Reopen from Web… 
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This option allows you to easily re-acquire Update access to a SmartRoster file 
that you previously had open for Update (in a previous session). If you close and 
re-open SmartRoster after having a WebShare file open, SmartRoster will 
automatically re-open the document (if “Open Recent” is ticked under the Open 
and save options) in Read-only mode. If you then select Reopen from Web 

SmartRoster will attempt to open a WebShare connection and open the file for 
you in Update mode. If someone else has already opened it for update then you 
will be notified who this is and have the option to contact them if your need is 
more urgent. 
 

WebShare Messages 

Any time you perform an action that invokes WebShare you will know this is 
happening because a small information dialog opens in the lower right of you 
screen. It looks like this: 

 

You will be able to tell what is going on at any time if you look at these 
messages. 

If your Annual support subscription expires, you will not be able to access our 
WebServers until support is renewed. However your data will be preserved. 

 

Automatic Updates 
SmartRoster provides a very simple facility to automatically poll for and 
download updates. Select menu File > Options. 

 

Tick the check box “Check for SmartRoster Updates at start-up”. Now everytime 
you run SmartRoster, if you are connected to the internet, SmartRoster will 
check to see if an update is available and give you the option to download it. 

Even if you do not have automatic updates activated, you can manually check at 
any time for updates by clicking on the button “Check for updates”. 

If an update is available you will be informed of this and given the opportunity to 
download and install it – all automatically!



CHAPTER 1  
SMARTROSTER BASICS 
 

 

24 

C H A P T E R 2  
Setting up 

    

     

    
How do I get 

started? 
 

 

 
o 

Chapter Contents 

System Requirements 20 

Installing SmartRoster 21 

Registering SmartRoster 22 

Getting Started with SmartRoster 23 

Setting Up A New SmartRoster File 24  

 Before you can start using SmartRoster's 

powerful scheduling features, you need 

to install SmartRoster, and set up your 

SmartRoster file, your role details, your 

people records, and your events. This 

chapter will walk you through all the 

major steps. 

 
CHAPTER 2 
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System Requirements 
To use SmartRoster, you will need the following equipment and software: 

o An IBM or compatible computer with a Pentium 100 MHz processor or better. 

o MS Windows 98, 2000, NT 4 Service Pack 5 or higher, or Windows XP. 

o Minimum of 64 MB of memory (RAM). We recommend 128 MB for optimum 
speed, especially if you have more than 200 personnel records. 

o A hard disk with at least 15 MB of free disk space. 

o 1Mb Video Card and monitor capable of 800x600 and 256 colours. However 
a 2Mb Video Card and monitor capable of High Colour (16 bit) resolution 
is highly recommended.  

o A printer supported by your operating system, preferably a page orientated 
printer such as an ink jet, bubble jet or laser printer. 

o Optional CD-ROM drive. 

o Optional Microsoft Internet Explorer and an Internet connection are required 
for Internet updates, and for accessing Internet information sites such as 
SmartRoster’s website www.smartroster.net . 
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Installing SmartRoster 

How do I install SmartRoster? 

Installation of SmartRoster is easy. In most cases, all you have to do is insert the 
SmartRoster installation CD in your CD-ROM drive and follow the onscreen 
instructions. 

1. Before you start the installation process, you should shut down all running 
programs. You may want to shut down your virus protection program, 
because some virus protection programs can interfere with installation. 

2.  Place the SmartRoster CD into your computer’s CD-ROM drive and close the 
tray. 

 

 

 

 

3.  Windows will start the installation, and display the Davallia Technology 
Software License Agreement. Click Yes to accept this and continue. 

4.  When the Choose Destination Location window is displayed, make sure that 
the drive and path are correct and that there is enough space on the hard 
drive to install SmartRoster. By default, SmartRoster creates a folder named 
C:\Program Files\Davallia\SmartRoster and installs the program to that 
folder. 

In most cases, you don’t need to change the directory. To change the destination drive or path 
click Browse, and change the destination folder on the Choose Destination Location window.  
When the path is correct click Next. 

5.  The Select Program Folder window will be displayed next. Use this window to 
put the program where you will be able to find it!  You can open an existing 
folder or create a brand new folder if you wish. 

6.  SmartRoster will now display the Start Copying Files window, which displays 
the progress of the installation process.  To start the installation process you 
need to click Next. 

7.  When installation is complete, the Installation Completed window is 
displayed. Click Finish to continue. SmartRoster is now installed to your 
computer.       

8.  To start using SmartRoster click on the icon you have installed. 

 

In most cases the installation should start automatically. If it doesn't then: 
1. Double-click on the My Computer  icon on the Windows desktop. 
2. Double-click on CD ROM drive  icon (this may be D: or E: drive). 
3. Double-click on the file that is called "Setup" or "Setup.exe". 
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Registering SmartRoster 
SmartRoster must be registered within 30 days of installation. If you are using 
the program on a trial basis, it will cease to operate after 30 days, until a 
registration key has been entered. 

A registration key is obtained when you purchase SmartRoster. Each time you 
reinstall SmartRoster, you need to re-enter your registration key, so it is a good 
idea to keep the key somewhere safe. 

To register SmartRoster 

1.  Obtain your registration key.  This can be done in one of two ways: 

• On purchase of the packaged SmartRoster product you should find the 
registration key on the envelope containing the CD ROM. If not then send 
us your details including proof of purchase and it will be mailed or 
emailed to you; or 

• On purchase of a copy of SmartRoster by download from the Internet, a 
registration key is automatically generated when your payment is 
approved, and will be sent to you by email; or 

• If you decide during or after your trial of SmartRoster that you wish to 
continue using this product, you need to send payment in full to the 
address provided with the product (check out the web site for details).  A 
registration key will then be generated and sent to you by return mail or 
email, as you prefer. 

2.  Access the registration window.  Either: 

• Use the registration window that is automatically displayed whenever you 
open an unregistered copy of SmartRoster; or 

• Click Register! on the menu bar (only visible if you have not registered 
previously).  
 

 

3. Enter the Registered Name: as it appears in your registration info. 

4. Select either Full or Trial and then enter either the number of licenses you 
have purchased or the number of trial days, as appropriate. 

5. Enter your key in the Key field and click Register.  



CHAPTER 2  
GETTING STARTED 
 

 

28 

 

Getting Started with SmartRoster 

The first time you start SmartRoster 

 
 
Each time you open SmartRoster, the Welcome to SmartRoster window will 

appear, giving you the option to create a new SmartRoster file (with or without 
the New File Wizard ), or open an existing file. This screen only appears when 

you open SmartRoster. However you can always create a new file or select an 
existing file from within SmartRoster by using the file menu. 

Opening an existing SmartRoster file 

 

Opening the sample file  

If you are using SmartRoster for the first time, you may want to open the sample 
file, which you can use to get a better feel for the program before you start to 
create your own file. To open the sample file: 

1. From the Welcome dialog, or from the File >  Open  menu, choose Sample 
SmartRoster File .  

2. Click OK.  

This will open the file Sample.ros, which is installed in your program directory. 

Use the sample file to explore SmartRoster. You can do anything you want in the 
sample file - enter data, run reports, and try all the features. When you’re ready 
to set up your own SmartRoster file, simply choose the File > New  menu. 

 
Opening an existing file  

If you’ve already created a SmartRoster file and you want to keep working on it, 
just select “Recently edited SmartRoster file” and click OK.  

If you want to open a different file, select “An existing SmartRoster file” and 
click OK. Then select a file from the Open dialog box. 
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Setting Up A New SmartRoster File 
If you haven’t yet set up 
your SmartRoster file, select 
“Create New File  and show 
New File Wizard” . This will 
open up the SmartRoster 
help file at Setting up a 
new file . This takes you 

step-by-step through the 
process of creating a new 
SmartRoster file.  

The New File Wizard  shows 
you how to enter details 
such as: 

• Organization name; 

• People, Households, or Groups; 

• Events and Roles. 

In addition, you can import the details about your people from another source. 

Setting up a new file. 

 

Step 1 Name your SmartRoster File 

Save your file before you continue any further. 

1. Select the File  > Save as  menu 

2. Type in the file name to save it as. 

3. Click on the Save button. 

It is recommended that you save your work at regular intervals. SmartRoster can 
do this for you.  

To activate automatic file saves:        

1. Select the File > Options  menu and click on the Open & Save  tab. 

 

2. Tick the Auto-Save  check box. 

3. In the Every ___ Minutes  box, type in the number of minutes to save your 

work and Click OK. 
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Step 2 Set Your Organization Name 

Set the name of your organization. This name will appear in the header of most 
reports generated by SmartRoster. 

 

1. To set your organization’s name select the File  > Options  menu. 

 

 

2. Fill in your organization name in the box called Name 

3. Click on the OK button 

Step 3 Define Roles 

1. Select the Role  > New menu 

2. Type in the name of the new Role and press the <Enter> or <Tab> keys 

3. Click on the General tab 

4. Double click on “<All Events> and enter the number usually required for this 
role (the default). You can also enter the number of times to block-schedule 
a person in this role (eg 2 weeks in a row). Don’t worry about the other 
options just yet. If unsure, you can change it later anyway. Click OK to 
continue 

Repeat steps 1 to 4 for many roles as you need to create. 

Step 4 Define Events 

Events are the meetings that your church or club schedules which may occur 
regularly (say, each Sunday or Annually) or may be a one-off occasion. 

1. Select the Events | New menu.  

2. Type in a name for it (e.g., Family AM Service).  

3. If it is a repeating event (like a weekly Sunday Service), select the repeating 
pattern from the tabs presented (eg Daily, Weekly, Monthly). If it is a 
specific date/time select the "Adhoc" tab and define the actual date/times 
and add them to the Include list. 

4. Click Add to add each pattern or adhoc date into the list of dates for this 
event. Repeat step 3/4 for each additional pattern or date/time. 

5. Click OK when you've finished defining the event.  

Repeat steps 1 to 5 for additional events. 
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Step 5 Match Roles to Events 

Now that you've defined your Events (services, etc) as well as your Roles, you 
need to tell the program which Roles are required by which Events. 

There are two ways to do this (it doesn't matter which you choose). 

 

To define all  ROLES for a specific EVENT:   

1. Open the Events panel (it is probably 
already open) and double-click on an 
event. 

2. Click on the Roles button. 

3. Tick the box next to all roles required 
by this event. 

4. You can also select for each role how 
many people are needed to serve in 
that role for that specific event. Also 
you can indicate whether, for a specific 
role, to always schedule the same 
person on consecutive occurrences of 
the event (eg, two weeks in a row). 
Just click on a role and then enter the 
details to the right. 

5. Click OK twice. 
 

 

To define all EVENTS for a specific ROLE:  

1. Open both Events and Roles panels (using the Toolbar buttons). 

2. Select a Role tab for which you want to define valid events. Select the 
“General” tab for that role. 

3. Click on an event, and while holding down the mouse button drag it into the 
Applies to Events  box in the Roles panel.  

4. Once again, you can set the number required to serve, and number times to 
schedule consecutively (see note 4 above). 

5. Repeat steps 2-4 for all events that apply.. 
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It’s now time to enter your People records. 

If you already have people records in an existing database, you can import these 
directly into SmartRoster.  For more details on how to do this see page 50 of this 
manual.   

You may like to hide all panels and show the People panel.  To do this, make 
sure that only the People  button is depressed on the Toolbar. 

This same panel can show: 

� Individuals   (select Show Individuals  from the People  menu) 

� Households       (select Show Households  from the People  menu) 

� Groups        (select Show Groups  from the People  menu) 

We normally start by entering Household records, as these are needed when you 
enter individual’s records next (but you can ignore households entirely if you 
wish and proceed to Add Individuals) 

 

 

Step 6 Adding Households 

1. Select the People  > New > Household  
menu 

2. Type in the household name. 

3. Select the Household Association from the Household Association  drop-

down box.  
(This allows you to define whether members of the household prefer to be, 
or NOT to be, scheduled for the same event). If an individual in the 
household has a different preference, you can select that when you enter the 
individual’s details later. 

4. Enter the household address, email, and phone numbers. 

5. If household members can only be scheduled onto certain events, add those 
events to the Events  list by selecting Events  tab. 

6. If you already know when this household is to be absent you can add the 
absences by selecting the Absences tab. 

7. When you're done, click Save.  Repeat 2 to 7 for more households or Close  
to quit. 
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Step 7 Add Individuals 

1. Select the People  > New > Person  menu 

2. Type in the person's Last name, Preferred name, Initials, and DOB. 

3. Select a household record for this person from the pull down list under 
Household.  This attaches the household information to this person’s record, 

and marks this person as belonging to the selected household. 

4. Enter the individual's address, email, and phone numbers ONLY if different to 
the Household. 

5. Update the Events  list only if different to the household record. 

6. Update the person's absences if known and different to the household 
record. 

7. When you're done, click Save.  Repeat 2 to 7 to add more individuals or click 
Close  to quit. 

 

Step 8 Create Groups 

Group definitions allow you to apply constraints, such as absences, to groups of 
people simultaneously. Groups are optional, and you can add them later if you 
want. 

1. Select the People  > New > Group  menu. 

2. Type in the name of the group. 

3. Select the Group Association (whether group members prefer to be, or not to 
be, scheduled on at the same time). 

4. Enter the group's contact details. 

5. As per Households and Individuals, update the Events for this group. 

6. Now add the actual members. To do this, select the Members  tab. Click 
Add . Select the members you wish to add and click OK. 

7. When you're done, click Save.  Repeat 2 to 7 to create other groups or click 
Close to quit. 

 

Step 9 Assign Contact Person for Role 

The Role Contact person is usually a team leader or coordinator responsible for 
that role. This person is listed on Schedule reports at the head of their respective 
schedule. You do not have to assign a Role Contact. 

To assign Role Contact:  

1. Open the People and Roles panels (You may need to change to Individual 
View ) 

2. Select a Role tab for which you want to assign a contact person. 

3. Drag and drop the contact person's name from the People panel to the 
Contact  field in the Roles panel. 
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Step 10  Assign People to Roles 

Now that you've defined your Individuals as well as your Roles, you need to 
assign Individuals to Roles.  These are called Role Members.  

There are two ways to do this (it doesn't matter which you choose). 

Using the Role Members context menu:  

4. In the Roles panel select the role tab to which you want to add members. 
Click on the “Members” tab for that role. 

5. Right-click over the Role Members list and select “New Member” from the 
menu. 

6. Select all the names you wish to make a role member (use <Shift> and 
<Ctrl> while clicking on a name keys to select multiple names) 

7. Click OK 
 

Using drag-and-drop:  

8. In the Roles panel select the role tab to which you want to add members. 
Click on the “Members” tab for that role. 

9. Show the People panel 

10. Drag names from the open people panel into the Role Members list 

 

Step 11 Assign Usage Targets for Role Members 

A usage target defines how often in a given period a person will be scheduled to 
a given role. A person can have a different usage target for each role to which 
they belong. 

The Automatic Scheduler attempts to fill each schedule so as to meet any 
individual usage targets provided. Where usage targets are not provided it tries 
to even out the usage as much as possible between all members who do not 
have such targets. 

To assign a usage target:  

1. In the Roles panel double-click on a person whose usage target you wish to 
set. 

2. Tick the Usage Target  check box. 

3. Enter the details as appropriate for this usage target. 

4. Optionally select the Event to which this applies (by default, All Events) 

5. Click OK. 
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Step 12  Define Role Compatibility 

By default, when a person is scheduled to perform in a certain role during an 
event, the Automatic Scheduler will not schedule them onto any other role during 
that same event. This means that, by default, all roles are incompatible.  

This may not always be the case, and you can indicate two roles are compatible 
(i.e. the same person can fill both roles at the same time). 

To indicate two roles are compatible:  

1. In the Roles panel click the tab of one of the roles to be made compatible 
(the “General” tab should also be selected). You will see a Compatible 
Roles  box. Click on the Add  button. A list of Roles will be presented. Select 
the role to be made compatible with this one. That role will be added to the 
list of compatible roles.  

2. Now right-click on the Role you just added (in the list), and select 
compatibility strength. 

Note: where compatibility strength is selected, the Automatic Scheduler will 
actively try to put the same person in both roles, where a person is on the 
list for both roles. 

Step 13 Absences 

You can enter absences for an Individual, a Household, or a Group. Entering an 
absence for a household will apply to each person in the household, and similarly 
for groups. Try to assign absences to a group or household if appropriate, before 
assigning to individuals. 

To enter absences:  

1. Open the People panel and double-click on the person (or household or 
group) and then select the Absences  tab.  

2. To define a new absence, click on the Add button. 

3. To edit an existing absence, double click on the absence. 

4. To delete an absence click on it once and click on the Delete button. 

5. Click Save to update the absences (click Cancel to cancel any changes) 

Step 14 Personal Associations 

For many reasons, some people prefer to be scheduled on the same events as 
other people, and some prefer not to be. For instance, a couple with small 
children may prefer not to be scheduled at the same time for childcare reasons. 

To add personal associations:  

1. In the People panel, double-click on the name of the person whose 
association you wish to add. 

2. Select the Associations  tab. 

3. Click “Add” to create a new association 

4. Fill in the fields as requested in the Edit Association dialog 

5. Click the Add  button. 
 

That's all there is to it. You can add as many other associations as you wish in 
the same way for this person, or click Save to finish. 
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Step 15 Set the Schedule Period 

Now you need to set the period over which you are creating the schedules. 

1. Open the Schedules panel if it is not currently visible. 

2. Click on the down arrow next 
to Scheduling Period:   

3. Click on the down arrow next 
to Start  or End to set the 

start and end dates for the 
scheduling period. 

The arrow buttons  >> and << can be used to advance the date range based on 
the current date range to the next (or previous) period equivalent in duration. 
Click “More >>” to access the look-back days functionality (p.62). 

 

Step 16 Assign Manual Schedule Entries 

At this point you need to add any manual entries into the schedules. You would 
do this where you want to fix a person to a schedule position, thus preventing 
the Automatic Scheduler from assigning this position. 

To do this: 

1. Have the Roles and Schedules panels open. 

2. Select the Role you want to use. Select a member from the Role Members  

window, and drag the name into the desired position on the schedules 
(normally into the same Role column). 

3. Lock the person into that position by clicking once immediately to the left of 
the person's name in the cell. A small lock symbol will appear.        

You can allocate as many positions as you wish - even the entire schedule if you 
want!  

Caution:  When allocating positions manually it is possible to override all 
constraints except for absences.  

You can also take names directly from the People panel and drop them into 
positions on the schedules, even if they are not members of the respective role 
(a guest speaker, for instance). 

You can also right-click in any cell and choose from a list of people to enter into 
the cell. 
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Step 17 Fixed Schedule Entries 

Typically, you will manually add entries to most, or even all, positions of some 
roles (such as the Speaker or Preacher role, which would rarely be automatically 
allocated) and you may even allocate all roles for SOME events (like a special 
memorial service or holiday).  SmartRoster allows you to lock in a whole Role 
(column) or Event (row) at a time. Locking a row, column, cell, or person in a 
cell will prevent the Automatic Scheduler from allocating or changing that 
row/column/cell/person. 

To lock a column (Role):  

Click once immediately to the left of the top-most cell of the column. This will 
be the cell that has the Role name in it. A small lock symbol will appear.  

 

To lock a row (Event occurrence):  

Click once immediately to the left of the left-most cell of the row. This will be 
the cell that has the Event date/time and name in it. A small lock symbol will 
appear. 

 

To lock a cell:  

Right-click in the cell. Select Lock Cell  from the popup menu. The text of the 

cell (if any) will appear greyed out. 
 

To lock a person in a Cell:  

Click just to the left of any name in any cell. A small lock symbol will appear 
next to the name, indicating it is locked. 

 

To unlock a single cell, row, or column:  

Click once on any lock symbol remove the lock, or right-click on the cell, row 
or column. 

Step 18 Pre-build Check List 

You are almost ready to build your first Schedule! 

Before you do, check that you have all necessary information: 

� Have you added all absences?  

� Have you added personal associations?   

� Have you added Household Associations?   

If all household members want to be scheduled on the same day, 
open the household record and set the Household Association box. 

� If all household members want to be scheduled at the same service on 
any given weekend, open the household record, select the Usage Target 
tab and set the Enforced Break to 2 days, and click “Applies between 
members as well as to each member” 

� Have you set usage targets for Role Members (where this is known)?   

� Have you manually added and locked in schedule entries where desired? 

 Remember: you can lock a whole row or column at a time. 
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Step 19 Building your first schedule! 

You are now ready to use the Automatic Scheduler.  

The Automatic Scheduler will fill all time slots not already assigned (and locked 
in). It will attempt to match as many constraints as possible while also meeting 
usage targets. 

1. Click Auto Fill  on the toolbar or select the Schedules > Auto Fill menu. 

2. Decide whether the Automatic Scheduler should bias towards meeting usage 
targets, associations, filling vacancies and in which order.  

3. Now tell the Scheduler when to stop trying to improve the schedule.  

Auto Fill Term Meaning… 

Iterations exceed Stop after generating this many schedules 

Time Exceeds Stop the Automatic Scheduler after this many 
seconds 

No improvement after Stop the Automatic Scheduler if it has not 
improved the schedule after this many attempts 

(Ignore the other options for now) 

Once you have set these Auto fill options, click Start to begin building the 

schedule. 

 

Step 20 Review your Schedules 

A number of tools are provided to help you review the quality of your schedule. 

1. Show Usage for persons and role members  (right-click in the People panel 
and select Show Usage , or select Show Usage  on the Roles menu) The 
number immediately to the left of each of the names in the People panel or 
Role Members panel tells you how many times that person has been 
allocated in the current schedule. 

2. As you move the mouse pointer over the schedules grid, it will highlight the 
name of the person currently under the mouse pointer everywhere that 
person is allocated. 

3. New SmartExplain technology explains, with a message in the status bar, 
why you cannot drop people into the schedule. 

4. The Status bar contains performance measures for the last successful build. 

 
Avg Usage Error  is the average difference between the usage targets for 
each individual role member, and that actually achieved by the scheduler 
(0.0% is the target). Association Preference Satisfaction  is a measure 
of degree to which associations have been satisfied (Larger is better). Vacant 
slots indicates the number of slots SmartRoster could not fill. 

5. Select Schedules  from the Report  menu to create Household or Individual 
Schedule reports.  You can then flip through these reports for each 
household, and review the suitability of the current allocations.  
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Congratulations! 

You have finished building your first schedule. What you might now like to do is: 

o Appraise the result and re-run the Automatic Scheduler. For example, you 
might find that only a part of the schedules is satisfactory. You could try 
locking it down before re-building.  

o Once you are happy with the result, check out the various kinds of reporting 
options you have (select Schedule  from the Report  menu). 

Finally, remember to consult the rest of this user manual, which has important 
information on many aspects barely touched on or not even mentioned here. 
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 People are the most important asset to 

any organization. You will want to create 

a schedule that is sensitive to the needs 

of your volunteers. This includes when 

they are available, what roles they are 

able to fill, How often they are available, 

and with whom they prefer to work. A 

better schedule will make best use of 

your valuable volunteer workforce. 

 



Managing People  
  

 

   41 
 

Introduction 
You manage people via the People panel. (See 
page 14). The People panel can be viewed by 
clicking on the People  button on the toolbar, or 
selecting the View > View People  menu. 

 People can be viewed as: 
� Individuals 
� Households, or 
� Groups 

by selecting the appropriate tab on the 
People panel. Anything that applies to an 
individual can also apply to a household or 
group. Any preference that is defined for a 
household or group applies to each 
individual in that household or group. 

Households are groups of individuals that live in the same household, and usually 
have the same last name. An individual can belong only to one household, but to 
many groups. 

Groups are arbitrary groupings of individuals (or even groups of households) and 
can be used to apply constraints (such as absences, associations preferences, or 
applicable events) to a number of individuals at a time. 

SmartRoster treats individuals, households, and groups in virtually the same way. the 
process of adding or editing individuals is very similar to that for households or groups. 
Because of this, in this manual, the word Person  can mean Individual, Household, or 
Group  unless otherwise indicated. "Individual" always refers to a single person but 

never to a household or group. 

The People Menu 
Most of the management functions you will need 
to perform on individuals, households or groups 
can be accessed from the dropdown People menu. 

New create a new Person  

Edit  edit the Person  that is 
currently selected 

Remove  delete the Person  that is 
currently selected 

Show Individuals  change the People panel to 

display only individuals 

Show Households  change the People panel to display only households 

Show Groups  change the People panel to display only groups 

Display as…  change the tabs that appear on the people panel to single 

letter, three letter, household, or no tabs 

Import  Import people from a tab-delimited format file 

Export  Export people in tab-delimited file format 

Hide(Show) Usage  Hides (or shows) the number of times each person is used 
in the current Schedules, as a  number in square brackets 
[x]. 
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Adding a New Person 
Select the People > New > Person  

menu. The top section includes basic 
name and household details. The 
following tabbed control contains both 
contact details and schedule 
preference information. 

The Household  field can be selected 
from the drop down list. If you are 
adding a person and have not created 
the person’s household record you can 
click on the Edit button and fill in the 

details of the new household, then 
come back to this window and select 
the household record you just created 
from the drop down list. 

A person's household address and 
phone details will appear as greyed text in the appropriate fields of the individual record, reminding 
you of information already available for the household. Only over-type it if the individual's details are 
different to that of their household details. 
 

Field Description  

Active Tick this box to make this person record active. Only active records will be automatically placed into 
a schedule by the Automatic Scheduler. 

Last name 
(Required) 

Usual Surname this person uses. This does not have to be the same as the household selected in 
the Household drop down box (below). 

Preferred name 
(Required) 

An individual’s preferred first name.  

Initials An individual’s middle initial.  Use this if two people have the same first and preferred names. 

DOB Date of Birth. This can be entered in any format. Year is not required. Used by the Birthday report 
function, and also reports date of birth in the address book. 

Household Select an existing Household record. You can create a new household record on the fly by clicking 
the lookup button. A person can only belong to one household. 

Family status Select either Father, Mother, Son, Daughter, Grandmother, Grandfather, Adult male, Adult female. 

Start Date Enter the date a person starts. SmartRoster will know not to schedule them before this date, and 
will adjust automatic usage targets accordingly 

TABS SmartRoster uses different tabs to store the different kinds of information. Just 
select the tab to access the information stored in that tabbed page. 

Address Street and email address information. Email is used for automatic reminders. Tick "Don’t include in 
directory" to exclude this person or household from the address list report. 

Telephone Work and home phone numbers, including fixed line, fax, and mobile. 

Absences Update a persons absences in this tab.  

Usage Target If you want to set a  usage target that will apply to this person across all or multiple roles, do so 
here. Also you can enter an Enforced Break for this person, and set a pre-assignments. 

Associations Set "prefer to be with" or "prefer not to be with" associations for this person. 

Events Set the events for which this person may be scheduled, and the event priorities for this person. 

Roles Shows the roles for which this person can be scheduled. 

Members This tab is visible if this is a household or group record.  Add or delete members of the household 
or group. 
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Notes Allows you to enter any arbitrary notes about this individual or household/group record 

Scheduled This tab shows all scheduled timeslots for the person being edited, similar to the email reminder 
format 

Usage Target 

Adding a usage target provides a limit which is used by the automatic scheduler 
when scheduling this person. 

To add a usage target, select the Usage Targets tabs and click on the Add 
button: 

  

To change an existing usage target click on the target in the list. Then click the 
Edit  button. Change the settings as required and finally click the OK button. 

To delete an existing usage target click on the target in the list. Then click the 
Delete button. 

Note: if you use a role-group or event-group then the limit will only apply within 
the roles or events specified for the role or event group. They will not limit how 
many times they are scheduled in other roles or events. 

Usage Target Interpretation 

"Average over whole schedule" applies the limit as an average across the whole 
schedule period including any look-back (this was the default behaviour prior to 
SmartRoster v2.5). This is the least restrictive interpretation. In this case the 
actual usage will approach or equal the usage target set here. Note a person 
could be scheduled many times in a row and have large gaps, while the average 
is still within the limit set. If that’s OK then this option may be suitable. 

"Max for each … period" applies the limit strictly to each contiguous period (each 
6 week period in this example). If this is selected then you will need to provide 
the starting date of the first such period (the beginning of the first 6 week 
period, in the above example). This is a more restrictive interpretation. 

1 Select the 
number  and 
Times ,  Hours , or 
Days  2 Select the period in 

which the number of 
times/hours/days applies.  
Note: “Scheduling Period” 
sets a limit for the current 
schedule, not including 
any look-back period 
 

4 Select the roles this 
applies to. You can select 
a Role group or tick select 
“All roles” if this limit 
applies across all roles. To 
create or edit a role group 
click on the Edit  button. 

5 Select the events this 
applies to. You can select 
an Event group or tick “All 
Events”. To create or edit an 
event group click on the 
Edit  button. 

6 Tick this box if the 
target is to apply only 
to the members of this 
group or household 
and not the group 
itself. 

8 Click OK to 
add it to the list 

3 Select the 
usage target 
interpretation  
(See below) 
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"Max in any … period" limits the number or times scheduled in any period of the 
given length, regardless of when the period begins. Starting date is therefore not 
required. In this case the actual usage averaged over the whole schedule will be 
less than the usage target set here. Hence this is the most restrictive 
interpretation. 

Usage targets for Households or groups 

When adding a usage target for a household or group you will also see a tick box 
Applies to Members only .  

This tick box allows you to easily apply a usage target to each member of the 
household or group (as if you went in to each member individually and created 
the same usage target for them) rather than the household or group itself.   

If you tick this box then you will see the usage target in the list with **Members 
Only**  appended. This usage target will then limit the number of times each 

member individually can be scheduled, but NOT limit the household or group 
specifically.  

If you have not ticked this box then the usage target will apply to this group or 
household as a whole. That is, this usage target will limit the sum total timeslots 
in which its members are scheduled. It will NOT put a specific limit on any single 
member alone. 

Enforced Break 

Setting Enforced Break for a person, household, or group instructs AutoFill to 

guarantee a break of the specified hours between successive timeslots for that 
entity. If specified for a group or household then the enforced break will apply to 
each member of the group or household. For instance, to prevent a person being 
scheduled at more than one event during a weekend, enter an Enforced Break of 
48 hours.  

If applies between members, as well as to each member is ticked, then if anyone in 

the group (assuming this is a group) or household is scheduled then no one else 
in the group will be scheduled within the enforced break period of this person. 
They may still be scheduled to the SAME event (same time period regardless of 
role). This is useful for insuring, for example, family members do not serve on 
different services on the same weekend, if they serve at all. 

Note: The usage target “2 times every 4-weeks” tells AutoFill to try to schedule the role member so 
that, over the whole period (including the Look-back period if set) the person will be scheduled 
in that role AN AVERAGE OF 2 times per 4-week interval. ie, if the period is three months, then 
it will try to schedule the person about 6.5 times over the whole period (2x13/4). Although 
SmartRoster will try to even-out this usage, these times could be all in the first two months, 
and they could (in the worst case) be consecutively. So, “2 times every 4-weeks” does not 
mean “every other week”. IF you want to skip every other week (for instance) then you should 
also use the enforced break for that role member, and set it to (say) 13 days. This will 

guarantee the break as desired.  

See also, Global Enforced Break page 123, Role Member Enforced Break page 
59. 



Managing People  
  

 

   45 
 

Pre-assignments  

Pre-assignments are a way of manually scheduling a person in a specific pattern 
that you set, rather then letting the automatic scheduler schedule them. You can 
do this for a role member in a single role, or for a person across a group of roles, 
or across all roles.  

Role-member pre-assignment 

You may pre-assign a role member to the schedule by ticking the Use pre-
assigned schedule  box in the role member dialog. Click "Edit" to define the fixed 

pattern for scheduling this person in this role, in the same way you set up an 
event pattern. Once pre-assigned, you will see this person shown in green in the 
relevant timeslots in the schedules grid.  

Tick "Pre-assigned and manual scheduling only" to tell SmartRoster to NOT 
assign any other timeslots to this person in this role. To remove the pre-
assignment untick the "Use pre-assigned schedule" box. 

Person preassignment 

You may assign a person to a specific schedule across a number of roles for that 
person. Open the person's record by double-clicking on the person in the people 
panel or in the schedules grid. Click on the "Usage Target" tab. In the bottom 
right of this tab you will see a checkbox labeled "use pre-assigned schedule" (If 
this box is greyed out then that person has not been allocated to any roles yet). 
Tick this box. Click the large "Edit" button to define the fixed pattern for 
scheduling this person, in the same way you set up an event pattern. Then select 
either <All Roles> or a role group from the "in roles" drop down box. 
SmartRoster will schedule this person in the pattern you specified, selecting the 
role to put them in from the roles you specified, trying to achieve the closest 
match to the person's usage targets.  

You can define role groups by clicking on the Edit box next to the role groups "in 
roles" drop down box. 

Tick "Preassigned and manual scheduling only" to tell SmartRoster to NOT assign 
any other timeslots to this person in this group of roles (or all roles). To remove 
the preassignment untick the "Use preassigned schedule" box. 

Note: SmartRoster will also try to fulfil role and keep-together associations when 
allocating this person in the preassignment pattern specified. It will not break mandatory 
role compatibility or association preferences unless you have de-selected Enforce 
associations when manually scheduling under Options: Other settings. 
Preassignments are considered to be a shortcut form of manual scheduling. 
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Association preferences 

The Associations tab is where you define association preferences for this person.  

Possible associations are shown in the box to the left. 

SmartRoster will always obey an Always keep apart and Always keep 

together association although you can override this by manual changes to the 
schedule. The stronger the association, the more likely it is to be satisfied.  

To add an association 

1. Click on the Add button.  
You will see this dialog: 

2. Select the person next to “associate 
with whom?” 

3. Select an association from the “What is 
the Preference”  

4. Optionally you may qualify the 
association by indicating it only applies 
to certain Events or Roles/Role-Groups. 
To do this select the Event and/or the 
Role or Role-Group from the relevant 
boxes. 

5.  “Always in same role” means the 
association will only apply if both 
people are in the same role. Note, if 
the preference is “always together” 
then they both should be members of 
the same roles.  

6. “Unidirectional association” means the association will only applies to the person 
names in the title: Association Preference for: It will not apply to the person 
selected in the Associate with whom drop down box. 

7. Click the OK button to add the association and Cancel to cancel the addition. 

To change an association 

1. Click on an association in the Personal Associations list (the main list) and click the 
Edit button. 

2. Make any changes as you wish to the association 

3. Click the OK button to change the association and Cancel to cancel the change. 

To delete an association 

1. Click on an association in the Personal Associations list (the main list). 

2. Click the Delete  button to remove the association. 

Notes:  

1. You can associate a person to themselves, also specifying a role/group and/or event. 
This effectively means that if the person is scheduled in one role, they prefer to also be 
scheduled in another role (as either in the role/role-group specified, or any other roles). 
This will NOT bypass role compatibility.  

2. You can specify that a group or 
Household Association preference only 
apply within a role/role-group or event. 
After creating the association by selecting 
from the Household Association drop-
down box, click on the Associations tab 
and you will see an association marked 
<Group Association>.  

Associations 
Always keep apart 

Strongly prefer apart 

Mildly prefer apart 

No preference 

Mildly prefer together 

Strongly prefer 
together 

Always keep together 
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Click on this and then edit the association in the normal way. 

 

Allocating Events to a Person - the Events tab 

 
(See chapter 4, page 61, for a description of Events.)  

Tick all events that apply to this person. By ticking an event, you make this 
person available to serve in any of their roles on any occurrence of that event. 

Event Priority (EP) 

Set the persons priority for an event by clicking on the event then selecting a 
priority in the "Set Event Priority" list box.  

EP was designed to allow you to alter the likelihood a person is selected for the 
different events in which they serve. If they serve only on one event, then 
setting EP has no effect on the automatic scheduler. EP will not effect the 
frequency that a person is selected compared to other people. Use the usage 
target to change the relative usage frequency between different people. 

Assigning Absences 

Absences are dates or a pattern of dates when a person (or household or group) 
may not be scheduled.   

To add absences, select the Absences Tab in the Update Person Details  

window, or click on the "Role Absences" button in the Role Member update 
dialog.  

The Absences tab lists all current absences for that individual (or household). 
These can be explicit dates, date periods, or patterns of dates. Below this list are 
the options to Add a new absence, Edit an existing absence, or Delete an 
existing absence .  

For most people you will normally indicate single absence dates, or date-ranges. 
You can also define patterns of absence. You can also define as many dates or 
patterns for the same person as necessary. 

To add a new absence record 

Select the “Absences” tab. Then click on the Add button. 

Fill in the Edit Absence dialog and click OK.  

To Edit an absence record 

Select an absence in the Absences tab and click the Edit button. 

Change the settings in the Edit Absence dialog and click OK.  

To Delete an absence record 

Select an absence in the Absences tab and click the Delete button. 

Hint! 
Always  add 
household or group 
absences where you 
can before adding 
individual absences. 
This is a convenient 
shortcut that avoids 
having to duplicate 
the same absence 
records for each 
member of a 
household (or group) 



CHAPTER 3  
Managing People 
 

 

48 

Include and Exclude Absences  

In the Edit Absence dialog, the top of the screen permits you to “Include” or 
“Exclude” an absence definition.  

If “Include” is selected then the dates or pattern are included in the list of 
absence dates. If “Exclude” is selected, then the date or pattern is excluded from 
the list of “included” dates (the person will NOT be absent on that date or 
pattern). 

For instance, if a person is absent on the 1st Sunday every month except for the 1st 
Sunday of the year, then create two absence records. The first will be “Include” 1st 
Sunday of every month, the second pattern will have “Exclude the 1st Sunday of every 12 
months starting Jan-1-06”. 

Assigning People To Roles – the Roles tab 

Once you have created a person record, you can assign that person to roles. 
Doing so informs SmartRoster which roles each individual can perform, so that 
when the Automatic Scheduler runs it knows who to assign to each role. 

To add a person to a role, right-click in the Role Members  list box on the main 
SmartRoster window and select “New Member”. You can also add people to roles 
by directly dragging them from the People panel into the Role Members list box. 

While editing a persons record, in the Roles  tab in, double-click on a role to edit 

the way that person interacts with that role. 

You can remove a person from a role by clicking once on them in the Role 
Members  list box in the Roles panel and hitting the delete key. Note that you can 

make a role member temporarily unavailable to serve a specific role by un-ticking 
them in the Role Members  list box. 

Recording Personal Notes - the Notes tab 

The Notes tab allows you to enter notes for the selected person, household or 
group. This allows you to record specific requests or other notes that cannot be 
stored in any other area of SmartRoster. This is for the benefit of the schedule 
administrator, and shows in the Personnel Inventory report. 

Adding a Household 
Adding a household is very similar to adding a person (individual).  

Select the People > New > Household menu.  

The dialog you see is very similar to that for individuals. However, Preferred 
name, Initials, and DOB are not present. 

You can indicate applicable events for this household (which would apply to all 
members of this household) by adding events into the Events  tab. 

Household Association Preference 

Also, instead of the Household  field, there is a Household Association  field. This 
is similar to personal association preference, but applies to each member of the 
household, and is the same as if each member of the household had a personal 
Association for each other member of the household equal to the Household 
Association entered here. 

You can specify that a Household Association preference only apply within a role/role-group or event. 
After creating the association by selecting from the Household Association drop-down box, click on 
the Associations tab and you will see an association marked <Group Association>. Click on this and 
then edit the association in the normal way. 
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You can also enter personal associations between this household and other 
individuals (or households or groups) by adding them in the associations tab as 
you do for individuals. 

Creating a Group 
The Group entity is a very powerful feature of SmartRoster that allows you to 
treat arbitrary groups of individuals as a unit. 

You can assign absences to a group, assign applicable events, and assign an 
association for all group members (preferring to be together or not to be 
together). For example, you could define Worship Group A as a team that is 
scheduled only on the Morning service, and must be together. 

To create a group, select the People > New > Group  menu. The Update Group 
Details dialog will display. This is very similar to that for households. You can, for 
instance, add a contact address for the group.  

Instead of the Household Association  field, there is a Group Association  field, 
which applies to each member of the group, and is the same as if each member 
of the group had a personal association preference for each other member of the 
group equal to the Group Association entered here. 

You can specify that a Group Association only apply within a role/role-group or event. After creating 
the association by selecting from the Group Association drop-down box, click on the Associations tab 
and you will see an association marked <Group Association>. Click on this and then edit the 
association in the normal way. 

To add a group member  

1. Select the Members  tab (on the far right).  

2. Click on the Add  button. This will bring up a list of all people. Select the 
names to add by clicking on them. Hold down the <shift> key while 
selecting to select a range, or the <control> key to add specific individuals. 

3. Click OK to add the selection to the list of members. 

4. Click Save to confirm the changes. 

Now that you have a Group, you can assign absences, applicable events, or 
associations to the group in the same way as you would for individuals. 

When does group availability apply to members? 

By default if a group or household is marked as absent, then each person in the 
group will be treated as absent. You can change this by un-ticking the “Group 
availability applies to members” checkbox in the Members tab of the Person 
Update dialog when editing a group or household. 
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Importing People Records 
Select the People > Import  menu. This allows you to import your people records 

from some other database, or to keep SmartRoster synchronized with another 
source of people data (say, if you maintain a database of people in some other 
form – possibly a Church Management System application). 

Select the People > Import  menu. The following dialog will display: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
5. Tick Delete records not added or updated to specify whether to delete existing records that were not 
added or updated after a delimited text file Import.  
 

S m a r t R o s t e r  I m p o r t  C o l u m n  D e s c r i p t i o n s  
ID Numeric ID for this person or household record 

HouseholdName Last name or surname for individual, or household name for household 

PreferredName Person’s preferred first name (leave blank if a household) 

Initials Person’s middle initial (leave blank if a household) 

HouseholdID The numeric ID of the household record this person belongs to. Only valid for 
records where PersonType=0 (see below) 

PersonType This defines the record type (numeric). 0 (zero) = Person record,  
1 (one) = Household record, 2 (two) = Group record. 

DateOfBirth Person’s date of birth 
AddressLine1 
AddressLine2 

Eg the street number and name, or the post office box number 

Town, State, Postcode Town, State and Postcode (or ZIP code) 

Email Person’s email address, or household email address 

HomePhone 
HomeFax 

If a Person, then the persons home phone numbers, if a Household, then this 
is the household’s home numbers 

WorkPhone 
WorkFax 

If a Person, then the persons normal work phone numbers. Not valid for 
Households 

PersonalMobile Person’s mobile phone number.   

HomeMobile A shared (household) mobile. 

1. Select the file to 
import. Click on 
this button to 
search the file 
system 

2. SmartRoster 
looks inside the 
import file to 
determine the 
fields (or columns) 
that are available 
for importing These are the 

SmartRoster 
columns into which 
you are going to 
import your data 3. You just drag a field 

name from the import 
columns and drop it on 
top of a SmartRoster 
column name to 
indicate where the 
import column data is 
to go. SmartRoster will 
already match columns 
in the import file that 
match the SmartRoster 
columns  

6. Click “Import 
Now” to start the 
import, once you 
have matched 
all relevant fields 

4. Automatically create 
household records when 
importing individuals 
based on common last 
names and addresses 
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Roles A list of roles for this person, eg "pianist|door greeter|song leader" separated 
by the pipe character "|". Optionally you can enter the Event that the role 
applies to in square brackets, eg “Pianist[AM Service]|Reader[PM Service]|… 

Events A list of events for this person (assumes the events are already set up  
Events are separated in the form: EventA;PriorityNum;EventB;PriorityNum 
where PriorityNum is 1(=v.low) to 3(=medium) to 5(=v.high) 

Import File Types 
There are two distinct types of file you can import. 

SmartRoster file format (*.ros) 

This is a normal SmartRoster (.ROS) format file. If you select one of these, the above 
column definitions do not apply. All you need to do is click Import Now  to start the import 

process. 

Importing a SmartRoster file.  

1. Select a file to import by clicking on the folder icon next to the Import File text box.  

2. In the Import dialog, select SmartRoster files  in the Files of 
type  box. Then select a SmartRoster file and click Open . 

3. Click Import Now . 

 

Delimited Format File (*.txt, *.cdf, …) 

Sometimes called “comma-separated format” or “tab separated format” files, these are 
plain text files where each line of text corresponds to a record of data. Each record (line 
of text) is further divided into fields, where a delimiter character separates the field values 
from each other. A delimiter is either a Tab character or a comma. Field values may be 
numbers (without quote marks around them), arbitrary text strings that do not contain 
the delimiter character, or text strings enclosed within double-quote marks that may 
contain the delimiter character. 

The first line of a DFF may optionally contain column headers, either within double quote 
marks or not, separated by the delimiter character. These column headers name their 
respective columns, corresponding to the values that will occur in subsequent lines at the 
same field position. 

Subsequent lines contain data values, one line per person or household record. Each 
line is a separate record. The data values are separated by a delimiter character and 
correspond to their respective column name. 

This is a very common industry-standard transfer file format, and many standard Church 
Management Software packages, as well as directory or spreadsheet programs, can 
export data in this format 

Importing a delimited text file.  

1. Select a file to import by clicking on the folder icon.  
 
In the Import  dialog, select Text (Tab/comma delimited)  in the  
“Files of t ype” box. Then select a file and click Open . 

 

2. Once you have selected a file to import, the left hand list will display the 
column names of the import file. If any of these matches the SmartRoster 
target columns, it will automatically be placed in the matching row to the 
right of the SmartRoster column name. Any SmartRoster target columns that 
are not matched in the import file will remain empty.  
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3. Manually indicate which import columns will go into which SmartRoster 
columns by dragging the import column name from the left hand list onto 
the SmartRoster column name you want it to import into. 

Note: If the list of import column names on the left hand only show Column1, Column2, 
Column3, etc then this means the first line in the import file does not contain column (or 
field) names. You can still import from this file if you know what each column refers to, 
but you can make it easier by editing the import file and adding a first row which 
contains column names (like “FirstName”<tab>”LastName”<tab>”DOB”<tab> 
”Address1”<tab>…<tab>…etc) and re-trying the import. However, make sure you use 
the same field delimiter character as is used in the rest of the import file. For instance, if 
the other lines use a comma to separate fields, then use a comma in the first (header) 
line too. If a tab character is used in the rest of the lines then use a tab character 
delimiter in the header line, and so on. 

4. Does your import file include Household records? If not, then tick 
“Automatically create household records” checkbox. This will create a new 
household record for each unique combination of last name and address that 
it finds, and automatically link individuals with the same last name and 
address to the household record. 

5. Click the Import Now  button to perform the import. 

Note that you can import into an existing SmartRoster file (or over a previous 
import of the same file) safely. SmartRoster will update the records that match 
the names in the import file and only add new records that do not already exist 
in the SmartRoster file. 

Importing Roles  

If you import the Roles column, SmartRoster will create a role with each role 
name in the list (if they don't exist) and add the person whose role list it is as a 
member of each role. 

Importing Events  

If you import the Events column, SmartRoster will create an event with each role 
name in the list (if they don't exist) and add the person whose event list it is as 
able to serving each event. 

 

Exporting People Records 
You can export your people 
records in tab-delimited format 
for importing into some other 
package (into Microsoft Excel for 
instance). 

Select the People > Export  menu. 

The following dialog box will 
display: 

Select a file by clicking on the 
folder icon. 

Tick all fields you wish to export. 
Tick “Export Household records” 
to include these in the export.  

Tick “Create first-line labels” to include the fields labels as the first row of the 
export file.  

Tick “Create a separate file for each role” to create a separate import file for 
each role which includes the role members of those roles. 
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Auto Import 
You may wish to regularly update your SmartRoster file from some external 
source. This may be a master SmartRoster file that someone else updates (and 
that may, for instance, be kept on a network drive), or it may be a routine 
daily/weekly extract from your organization’s human resources database package 
(such as your Church Management Software application). 

In this case, you may want SmartRoster to automatically update your people 
information in a SmartRoster file from this source.  

To automatically import into your SmartRoster file every time you load it 

1. Select the File > Options  menu. 

2. Click on the Import  tab. 

3. Tick the Auto-Import  check box. – You will notice that the Edit Import Spec . 

button becomes activated. 

4. Click on the Edit Import Spec . button. You will now see the Import  window 
just as you did to manually do an import. Fill out this form just as you do to 
do an import. 

5. Click OK.  

Now auto-import is active for your current SmartRoster file (Make sure you save 
the file now to save this change). 

 

Custom Fields 
You can now create and use your own fields for personnel. These fields allow 
you to store any kind of textual or numeric information that is not possible by 
other methods. For instance you can set up your own fields to store “important 
dates”, “qualifications attained”, “location” or anything else. You can import into 
these fields using the import function, report the information using the 
customisable Personnel Inventory report, or create a filter based on values 
stored in these fields. 

Creating Custom Fields 

To define custom fields select  File > Options and select the Custom Fields 
tab. You will see the following ” panel. In this you just type the name of your 
custom fields, one field per line, as shown: 

 



CHAPTER 3  
Managing People 
 

 

54 

 

Entering data into 
Custom Fields 

To enter values into these fields, 
edit a person record and select the 
Notes tab. These fields will appear 
on the left:  

Alternatively you can import data into these fields. The new fields will appear in 
the Import dialog at the bottom of the list of standards SmartRoster fields. You 
just drag and drop the import field onto the appropriate custom field as you 
would do for any standard field. 

Reporting custom fields 

You can report these fields by selecting the Personnel Inventory report. This 
allows you to select any existing SmartRoster field as well as your custom fields. 
The Custom fields appear in the list of fields to choose with a prefix “Custom_” 
before them.  

Filtering based on custom fields 

You can create a filter based on custom fields in exactly the same way you filter 
on other standard fields. Just select the field name from the drop-down box (it 
will have the “Custom_” prefix just like when you select fields to report). 

The filter can be used to limit the people you see in the people panel, to define 
dynamic groups, or to limit the people you are selected for a given report. 
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C H A P T E R 4  
Managing Roles 
and Events 

    

     

    
What Roles do I 

need, and how do 
I set up repeating 

Events? 
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 Many diverse roles within your 

organization are required to stage the 

regular events critical to your purpose.  

Defining roles and allocating suitable 

people to them, defining your events, and 

deciding which roles are required for 

each event are described in detail in this 

chapter. 
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Defining Roles 
First let’s recap on how we define a role. 

A role is a position, sometimes called a ministry or task, which needs to be filled 
by one or more suitably qualified persons in order to stage an event. For 
example, in a Church Service, “Organist”, “Overhead Projectionist”, or “Reader” 
may all be required roles. Individuals may be assigned to one or more roles. 
When assigned to a role, the individual (or another person) can nominate a 
desired frequency of usage (such as once a week, twice a month, or 7 times a 
year). The Automatic Scheduler uses this information to balance the schedule as 
fairly and appropriately as possible. 

When you start a new SmartRoster file, no roles have been created. Roles are 
created and managed in the Roles panel, 
which is visible on the main window by 
clicking on “Roles ” in the main toolbar. 

 

The Roles Menu 

You will manage Roles by selecting 
from functions on the Roles menu. 
This menu is activated by either 
clicking on the yellow arrow under 
the word “Roles”, or by from the 
main menu bar. 

New Create a new Role 

Remove  Delete the Role that is 
currently selected 

Order 
Roles…  

Change the order of 
the role tabs within 
the tab or list control. 
Changing the order of 
the Role Tabs also 
changes the order of 
Role columns in the 
Schedules grid. 

 

Pattern … Restrict the dates on which the selected Role is required, or remove 
such a pattern. 

Display 
as… 

Change the Roles panel to show Roles as either tabs or as a list 

Role 
Members…  

This sub menu allows you to add new members to this role, edit 
members, remove members, Copy the list to the clipboard, change 
the list view style (from List to Detail), change the name format, hide 
(or show) members’ usage (their scheduled count), and whether or not 
to show only members available for selected events, or all members. 
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Creating A New Role 
1. Select menu Roles  > New 

You will see a new Roles list item tab, prompting you for the name of the 
new role   

 

2. Type in the name of the new role and press the <Enter> key.  
 
You will notice that Roles are displayed in a list, with three tabs “General”, 
“Members”, and “Notes”. To add information to a role you need to select the 
appropriate tab. 

Notes 

� To change the name of a role, double-click on the name in the list tab and then type in the 
 new name. 

� If you want to enter all role names in rapid-fire manner and fill in their details later, press the 
Tab key three times after entering the role name (step 2 above). It will automatically create a 
new tab and ask for the name of the new role. Use the <Enter> key to finish creating new 

Roles. Once you have created the Roles, select each in turn and update the other details. 

Applies to Events 
Where a role is only required for a subset of events, these need to be entered in 
the Applies to Events  box (in the General tab) by dragging them from the Events 

list in the Events Panel. 

For each event (or for All Events) you can define: the number of people 
required; whether to schedule in blocks of x events; any additional restrictions 
that may apply. See Matching Roles to Events below. 

Role Compatibility 
If a person is assigned to a certain role during a particular event occurrence 
(that is, on a specific date/time) can they also be assigned to any other role for 
that same event? That depends on whether the other roles are compatible or 
not with this role. 

By default, roles are not compatible with each other!  A person cannot be 
assigned to incompatible roles during the same occurrence of an event 
(Occurrence refers to a row in the Schedules grid). 

To make roles compatible you need to mark them as compatible. SmartRoster 
allows you to specify not only whether roles are compatible, but also the degree 
to which they are compatible – from “Not incompatible” which means “A person 
may be scheduled into both roles, but the Auto Fill will not try to put the same 
person into both” to “Mandatory” which means “The same person must be 
scheduled into both of these roles”. 

You do this in the Compatible Roles  box in the Roles  panel, under the “General” 

tab. 
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How to make two roles compatible  

1. Click Add button in the 
Compatible Roles  panel. The 
following dialog shows:  

2. Select the role to be made 
compatible to the current role in 
the dropdown box 

3. Choose the strength of 
compatibility  

4. If this only applies to a certain 
event, tick “only Selected Event” 
and select the event in the drop 
down box. 

5. Click OK to add this role compatibility. 

The higher the degree of compatibility, the harder the Auto Fill will try to put the 
same person in the respective compatible roles on the same event occurrence. 

Note that role compatibility will only effect people who are available for (are role 
members of) both roles in the role compatibility record. 

 

Adding Role Members 
There are two ways to add people to a role (it doesn't matter which you choose). 

Using the Role Members context menu:  

1. In the Roles panel select the role tab to which you want to add members. 
Click on the “Members” tab for that role. 

2. Right-click over the Role Members list and select “New Member” from the 
menu. 

3. Select all the names you wish to make a role member (use <Shift> and 
<Ctrl> while clicking on a name keys to select multiple names) 

4. Click OK 
 

Using drag-and-drop:  

1. In the Roles panel select the role tab to which you want to add members. 
Click on the “Members” tab for that role. 

2. Show the People panel 

3. Drag names from the open people panel into the Role Members list 

 

To remove a role member:   

Right-click on their name and select remove. 
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Role Member Parameters 

To edit role members, select all the members you wish to edit (hold down the 
control key to select multiple names) in the Role Members panel. Then right-click 
and select edit. 

 
 

Usage 
Target 

To add a usage target: 

� Tick “Usage Target” 

� Indicate the usage 
- number of Times or Hours or Days 
- the period over which this applies.  If you select "Scheduling Period" this does NOT 
include any look-back period 

� Set the usage interpretation (see below) 

See also, Personal Usage Targets, page 43 

Overcommitted Usage Target 

At times you may see the word “Overcommitted” show in the Role Members panel title 
bar.  This means that you have set usage targets for that role which, added together, 
exceed the total number of timeslots available to people in that role. However, you can 
still use AutoFill with overcommitted targets. Sometime this is appropriate if this is 
actually used as a limit and not a targe. 

Usage 

Target 
Interpreta-

tion 

 

"Average over whole schedule" applies the limit as an average across the 
whole schedule period including any look-back (this was the default behaviour 
prior to SmartRoster v2.5). This is the least restrictive interpretation. In this case 
the actual usage will approach or equal the usage target set here 

"Max for each … period" applies the limit strictly to each contiguous period 
(each 6 week period in this example). If this is selected then you will need to 
provide the starting date of the first such period (the beginning of the first 6 
week period, in the above example). This is a more restrictive interpretation. 

"Max in any … period" limits the number or times scheduled in any period of 
the given length, regardless of when the period begins. Starting date is 
therefore not required. In this case the actual usage averaged over the whole 
schedule will usually be less than the usage target set here. Hence this is the 
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most restrictive interpretation. 

Example; if you set "1 time per 2 months, Maximum for each 2 months, starting 
1/1/06", then smartroster will limit this role member to on time only in each 
consecutive 2 month block, regardless of the total period over which the 
schedule is being created. If you had set "average over the whole schedule" and 
you were scheduling for 4 months with a two month LBP, then smartroster 
would insure that role-member was not scheduled more than 3 times in the 6 
month planning horizon (=4 months active schedule + 2 months LBP). However 
this will not prevent them possibly being scheduled thrice in one calendar month 
and no times in the other months, even though this is unlikely. 

Enforced 
Break 

Usage can also be limited for this person in this role and (optionally) the event specified 
in “Event”, by specifying an Enforced Break. This instructs AutoFill to guarantee a break 
of the specified hours between successive timeslots for the same individual for this role.  

See also, Person Enforced Break , page 44, or Global Enforced Break, page 123. 

Event /  
Next Event 

Select an Event if this usage only applies to a specific event. By setting Event you can 
limit this person only to the Event specified. If they only ever serve on a given event 
regardless of role, then you should set this under the persons details via the People 
panel. 

You can add the same person multiple times into the role members list, with a different 
usage for different events. This gives you fine control over which events a person can fill 
in each of their roles, and the usage target for each such role/event combination 

"Next Event" allows you to indicate that, whenever this role member is scheduled 
automatically in the "Event" given in the event field, then they should automatically be 
scheduled into the next available timeslot for the event specified in "Next Event". eg, if 
Event is "Sunday AM" and "Next Event" is "Sunday PM" for "Joe" in role "Setup", then IF 
SmartRoster schedules the person to "Sunday AM" role "Setup", then Smartroster will 
automatically schedule them to the very next "Setup" timeslot for the "Sunday PM" event.  

Start Date Indicate when the role member started in this role. If they start after the beginning of the 
current schedule period then SmartRoster will not schedule them before this time.  

Spare Tick the “Spare” checkbox to designate a person as spare. Autofill will only try to 
schedule the person in this role if no one else is able to fill a slot. You can still use Usage 
Targets to set a the maximum that this person can be used, even if no one else is 
available. 

Trainee Tick the “Trainee” checkbox to designate a person as Trainee. Autofill will only allocate a 
Trainee after already allocating a non-trainee. ie. a Trainee cannot be scheduled in a 
timeslot on their own or only with other trainees. 

Report groups/households as list of members 

 When scheduling with groups or households this option allows you to report them in 
schedule reports by replacing the name with the list of members of the group/household 

Role 

Absence 

Enter absences for the person in this role (and event if specified). This allows you to 
specify when a person is absent for the purposes of this specific role, in addition to any 
other absences for the person or their household. See page 47 for a description. 

Pre-
assignments 

You may pre-assign a person to the schedule by ticking “Use preassigned schedule”. Click 
“Edit” to define the fixed pattern for scheduling this person. The pattern may be any 
pattern that can be defined for an event. Once pre-assigned, you will see this person 
shown in green in the relevant timeslots in the schedules grid. Tick “Preassigned and 
manual scheduling only” to tell SmartRoster to NOT assign any other timeslots to this 
person in this role. To remove the preassignment untick the “Use preassigned schedule” 
box. 
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Role Groups 
Role groups are used for restricting usage targets for individuals, households, or 
groups to only a subset of roles. 

To edit role groups select Role groups  from the Roles  menu. 

The following dialog will be displayed: 

 

In the left hand side will show a list of any role groups you have previously 
defined. 

You will see under “Available roles” a list of your roles. 

Click on <New> in the list to create a new role. Name the role group in the 
“Name” field. Then select all the roles in this group from the “Available roles” list 
(you can use the <Shift> or <Ctrl> keys to extend your selection) and click th e 
double right arrow  button to add them to the “Roles in group” list. Once you’ve 
finished click the Add  button to add this new role group to your list. 

To edit an existing role group click on the role group in the left hand list, make 
any changes you require, and click on the Update  button (the Add  button will 
change to Update  when you click on an existing role group). 

Linked Role-members 

Tick the check box “Linked Role-members” to have all the roles in the selected 
role-group linked. When roles are linked, any changes made to role members of 
one role will automatically be replicated to all other roles in the role group.  

Colour 

You can optionally change the colour for this role group. All roles in the main 
schedule panel will have their heading in this colour. The text will be in white if 
“Show name in white” is ticked. 

 

Defining Events 
Now let’s recap on how we define an event. 

SmartRoster uses the term event to mean a series of meetings (for a Church, 
this could be Mass or a Worship Service) with the same role requirements, 
occurring on arbitrary dates, according to a regular pattern of dates, or both. For 
example, Sunday 10AM Service may be an event that occurs every Sunday and 
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needs a Speaker, Leader, 2xSingers, Organist and 2xUshers. Sunday AM Service 
on 3rd March 2002 10:00am is one instance or occurrence of the event Sunday 
AM Service. You may have also defined this as NOT occurring on a specific 
date. 

When you start a new SmartRoster file, no events have been defined. Events are 
defined and managed in the Events panel, which is visible on the main window 
by clicking on Events in the main toolbar.  

The Events Menu 

You will use the Events  menu to create, delete, and edit 

events. 

New Create a new Event  

Edit  Edit the Event that is  
currently selected. (You can  
also double-click on an event to edit it.) 

Remove  Delete the Event that is currently selected 
 

Creating a New Event 
1. Select Events > New  menu 

 
The New Event  window displays: 

 

2. Fill in the name of this event in the Event Name  box. Keep this as succinct as 

possible, because it appears in the Schedules grid. 

3.  You can select a colour for this event which shows in the main schedules 
panel. The text will be in white if “Show name in white” is ticked. 

4. Enter an optional Event Enforced Break if needed. SmartRoster will then NOT 
schedule a person within the enforced break hours/days after being 
scheduled to this event. 

5. Now define dates/time pattern/s or arbitrary dates which make up this event. 
You can add as many patterns or arbitrary dates as you wish.  

 

To add a pattern click the Add button. You will see the following dialog: 
 



Managing Roles and Events  
  

 

   63 
 

 

Adding a Date Pattern or arbitrary date/time 

Select the type of pattern: Single date, Date range, Daily repeating, Weekly 
repeating, etc. 

The select the various fields that are in the Yellow highlighted box appropriate to 
the event type you have selected.  

Eg.  to define a weekly service that occurs every Sunday at 10:00am for 1 hour, first select "Weekly 
repeating pattern", make it recur once every week, and tick only the Sunday check box, and enter 
the time 10:00am and select 1 hour 

In most cases you need to define the start time and duration of the event by 
setting the Time…For…boxes:  

  

To finish adding a pattern, click the Add button. The pattern will appear in the 
list of patterns for THAT event.  

 

To exclude specific dates or a date-pattern 

Each adhoc date or date-pattern can be either “Included” or “Excluded” from the 
overall event dates. If “Include” is selected when you click Add, then the 
date/times defined by this pattern will be added to the total date/times of this 
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event. If “Exclude” is selected, then the date/times defined by this pattern will be 
removed from the total date/times of this event 

Copy all event settings from another event 

Just select from the <Copy From> drop down box and select another event (if 
you have already defined another event). All the values will be copied into this 
event which you can then modify as necessary. 

Event Groups 
Event groups are used for restricting usage targets for individuals, households, 
or groups to only a subset of events. 

To edit event groups select Event groups  from the Events  menu. 

The following dialog will be displayed: 

 

In the left hand side will show a list of any event groups you have previously 
defined. 

You will see under “Available Events” a list of your roles. 

Click on <New> in the list to create a new role. Name the event group in the 
“Name” field. Then select all the events in this group from the “Available Events” 
list (you can use the <Shift> or <Ctrl> keys to extend your selection) and click 
th e double right arrow  button to add them to the “Events in group” list. Once 
you’ve finished click the Add  button to add this new event group to your list. 

To edit an existing event group click on the event group in the left hand list, 
make any changes you require, and click on the Update  button (the Add  button 
will change to Update  when you click on an existing event group). 
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Matching Roles to Events 
To recap: An event is defined as a repeating sequence of meetings (for any 
purpose) that have the same role requirements.  

Therefore for each event you have defined, you need to indicate which Roles are 
required. 

There are two ways to do this. It doesn't matter which way you choose. 

Specify all ROLES required 
for a specific EVENT 

1. Double-click on an event in the Events 
panel to edit it. 

2. Click on the Roles  button. 

3. Tick the box next to all roles required by 
this event. 

4. Double click on each selected role to edit 
the role-event properties (see Adjusting 
Role-Event properties below) 

5 Click OK. 
 

Specify all EVENTS that 
require a specific ROLE: 

1. Open both the Events and Roles panels (using the Toolbar buttons)  

2. Select a Role for which you want to define valid Events, and the General 
tab. 

 

In the Applies to Events…  box you will see all the events that this role applies 
to 

3. Click on an event, and while holding down the mouse button, drag it into the 
Applies to Events  box. 

4. Drag as many events as apply to this role into the Applies to Events  box. 

5. Now you can adjust the Role-Event settings (see next page). 
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Adjusting Role-Event properties 

 

To adjust the Role-Event settings, double-click on any Event in the Applies to 

Events… box. You can adjust multiple role-events by <shift> or <ctrl> clicking 
on multiple events in the Applies to Events… box and then right-click and 
“edit”. 

The Role Event Properties dialog will show: 

 

“Schedule at least”; “Schedule at most” 

“Schedule at least” is the normal target SmartRoster will use when Auto 
Scheduling. “Schedule at most” is used to schedule people with positive 
association preferences to people already scheduled, and gives SmartRoster 
some flexibility in meeting these associations. Usually you will set both limits to 
the same number. 

“Schedule the same person consecutively”   

This setting allows for block scheduling of the same person. For instance, 
specifying that a person be scheduled "Consecutively X Times" for a role in event 
EV tells SmartRoster to always put them person in X consecutive slots for the 
same event (eg the next 3 "Sunday AM service"s in a row), regardless of the 
length of time spanned by those events. If you specify "Consecutively X Days" 
for a role in event EV, then the person is scheduled for as many EV events as 
occur in the specified days, regardless of how many times that is.   
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Setting "1 times" is the default and simply means to schedule the person once. 
Setting "1 month" will cause the person to be schedule for all occurrences of the 
specified event that occur in the next 1 month.  

“Treat groups as one person when scheduling” 

If you want groups which are also Role Members to be treated as if they were a 
single person then tick this box 

“Round Robin scheduling” 

If this is ticked, SmartRoster will schedule this role-event by selecting each role-
member in turn from the role-members list. SmartRoster will ignore any 
association preferences while scheduling this role-event. It will consider absences 
though, and will ignore any person who is not available when their turn comes 
up. 

The order of role-members can be set in the role-members panel. To set the 
order, first you must turn off the default role-member sorting. Right-click in the 
role-members panel and untick the “Sorted” menu. 

Now you can order the role members simply by dragging the names up and 
down the list. 

“Auto number people in this role-event” 

If this option is selected then SmartRoster will automatically number each person 
in each scheduled-timeslot. 

“Secondary Role” 

If this option is selected then SmartRoster will require a person to be scheduled 
in another role that is compatible to this one during the same event, before it will 
schedule that person in this role. In other words, only schedule in this role/event 
a person already scheduled in the same event on another role. 

Reminder messages 

Simple text msg 

This text message will appear in reminder emails to this person. 

File Attachment 

If this is used, then the file will be attached to any reminder message sent to the 
person scheduled in this role/event combination. 

Restrictions based on group membership 

Role-Event Restrictions are a powerful feature that allows you to restrict the 
persons selected in a timeslot depending on their group-membership.   

To create any restriction you first need to define a group on which to base the 
restriction. 

Role-Event Restrictions 

Role-Event Restrictions apply to a single role-event pair and are defined after 
selecting a role-event in the “Applies to events” panel. 

Example:  To Role-Event  restrict the number required to “at most 1 male” : 

1. Create a group called “Male” (in the main SmartRoster window, People panel) 

2. Add into that group all the males 
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3. Double click on the Role-Event for which you want to restrict the number of 
“Male”s scheduled 

4. Click on <New Restriction> 

5. In the first drop down box next to  <New Restriction> select “At most” 

6. In the second drop down box select “1” 

7. In the third drop down box select “Male” 

8. Click OK. 

To delete a restriction, select the restriction in the list and click on Delete. 

Global Restrictions 

A Global Restriction applies over a groups of roles or all roles, and to all events 
or only a group of events.  

To create any global restriction you may first need to define a role-group on 
which to base the restriction (as well as a person group). 

Example:  To require at least one Soprano voice to be schedul ed across all 
vocal roles in any service : 

1. Create a group called “Soprano” and add into that group all the sopranos 

2. Create a Role-group called “Singer roles” and add all the vocal type roles 

3. Select menu Roles > Restrictions. You will see the following dialog: 
 

 
 

4. In the first drop down box select “At least” 

5. In the second drop down box select “1” 

6. In the third drop down box select “Soprano” 

7. In “…across roles” select “Singer roles” role group 

8. Leave “Applies to events” set to <All Events> 

9. Click Add and then Close. 

Now when AutoFill runs, SmartRoster will make sure that at least one person 
who belongs to the people-group “Soprano” is selected in one of the roles 
belonging to the “Singer roles” group of roles. 
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C H A P T E R 5  
Creating And 
Using Schedules 

    

     

    
How do I set up 
and manage my 

schedules? 
 

 

 
 

Chapter Contents 

 

Setting Scheduling Period / Look-back 
days 60 

Manual Schedule Allocation 61 

Locked Schedule Entries 62 

Adding Schedule Comments 63 

Automatic Schedule Generation 63 

Initiating Auto Fill 65 

Post Fill Review 69 

Exporting the finished schedules to other 
programs 70 

Attendance monitoring and reporting  71  

 Once you have set up your SmartRoster 

file, your people (individuals, households, 

groups), roles, and events, you can begin 

the actual process of scheduling. 

SmartRoster makes scheduling easy, but 

even more importantly; it can 

automatically do most of the scheduling 

work for you. The Automatic Scheduler is 

SmartRoster's most powerful feature, the 

one that really sets it apart from the 

competition. You won't believe how easy 

scheduling can be with SmartRoster! 
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Setting Scheduling Period and Look-back days 
You will construct your schedules in the Schedules panel. See page 17 for a 
summary of the features of this panel. 

The first step in creating schedules is to set the time period to be covered by the 
schedules. 

1. Open the Schedules panel if it is not currently visible. 

 

2. Click on the down arrow next to Scheduling 
Period  box. Then choose the dates in the 
Choose Period  dialog by settings the Start 

and End dates and click OK.  

 

A row will appear in the Schedules grid for each event that occurs during the 
scheduling period.  Also, a column will appear in the Schedules grid for each role 
you have defined (but only if the Include on Schedule  check box is ticked in the 
Roles panel). If no dates appear it may be that you have not defined any 

events. In this case go back and define your events first (see page 61). 

 

Setting the "Look-back" days 

Look-back days are the days that the automatic scheduler will consider before 
the start date of the scheduling period. The automatic scheduler will take into 
account who is filling roles prior to the current range when determining who to 
select for roles in the current range. The look-back days should be large enough 
so that everyone in every active role could be expected to be scheduled at least 
once in the period that includes the current scheduling period and the look-back 
days. 

To set look-back days you click the More button in the Choose Period dialog.  

You will see the following >> 

Enter the number of days in the 
Days edit box. You can decide 
whether or not to make these visible 
in the Schedules panel by ticking the 
Make Visible check box.  

Even if they are visible, the 
automatic scheduler will not allocate 
these days. It only refers to these 
previous allocations when allocating 
roles in the current period.  

If you tick “Auto Calculate” then SmartRoster will work out an appropriate value 
for you. 
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Manual Scheduling 
You can manually schedule people by drag-and-dropping them from the Role 
Members  list or from the People panel. Do this before running the Automatic 
Scheduler when you want to fix a person to a schedule position, thus preventing 
the Automatic Scheduler from assigning that position. 

 

 

 

You can allocate in this way as many positions as you wish. 

 Warning!   

When you allocate positions manually, non-mandatory personal associations, such as 

"likes to be with…", will be ignored 

You can also drop names directly from the People panel into positions on the 
schedules, even if they are not members of the respective role. This allows for 
one-off exceptions, but it is up to the person doing the schedule to make sure 
such allocations are appropriate. 

Enforce associations with manual scheduling 

If you tick the option with the above name (in the “File > Options” menu and the 
“Other” tab), then when you drop a person into a scheduled timeslot, 
SmartRoster checks to see if there are any other people who have a “Always 
keep together” or “strongly prefer together” preference with that person, and 
automatically adds them into appropriate timeslots for the same event.  

1 Have the Roles and 

Schedules panels open… 2 Select the Role you 

want to assign to in the 

schedule.  

4 Select a member 

from the Role Members 

list 

5a drag the name into the desired 

position on the schedules (normally 

into the same Role column) 6 Optionally lock 

the person into 

this position by 

clicking once 

immediately to 

the left of the 

person's name in 

the cell. A small 

lock symbol will 

appear. 

3 Select the 

Members tab.  

5b Optionally, instead of 5a above, 

you can right-click over a cell to 

access and select a name from the 

list of those available for that slot 
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Moving items in the schedules using the mouse 

You can simply move individuals up and down in the same schedule or even to a 
completely different schedule by clicking on them and, while holding the left 
mouse button down, dragging them to the other cell. This is called “drag and 
drop”.  

As you drag the mouse the mouse pointer will adopt one of two forms: 

 
Drop-Valid.  The person may be dropped in the 
current cell (by releasing the left mouse button) 

 Drop-Invalid. The person cannot be dropped into the 
current cell. 

Drop-Invalid will show if the person is absent on the day/event over which you 
are moving or if the person is not a member of that Role. 

• To remove a person from a position, click once to select the person (the 
person’s name will appear as bold text). Then hit the <Delete>  key on the 
keyboard. 

• To move a person from one cell to another simply drag-and-drop them.  The 
person will be removed from the source cell and added to the person or 
persons already in the destination cell. (Note: you can add as many people 
as you like to one cell).  

• To copy a person from an existing cell, hold down the <Ctrl>  key while 

performing the drag-and-drop. The person will appear in both the source 
and destination cells. 

• To swap two people, hold down the <Shift>  key while performing the drag-

and-drop. The person will appear in the destination cell, and person or 
persons that were there will now appear in the source cell. 

• To move a person and replace the existing contents of the destination cell, 
hold down the <Shift>  and <Ctrl>  keys while performing the drag-and-drop. 

The person will appear in the destination cell and any existing occupants of 
the destination cell will be removed. 

• To move a person into a cell in which they normally would be invalid, hold 
down the <Alt> key while performing the drag-and-drop.  

• It is possible to move people between roles in the Schedules grid using the 
methods outlined above. 

• As you move a person to another role using the drag-and-drop method, the 
mouse pointer will only show the Drop-Valid icon if the person is a member 
of the role over which you are currently moving. 

Showing rule violations 

Where you have manually alocated people to the schedule, or added constraints 
(such as absences) after scheduling a person, it is possible to create rule 
violations. You can see these violation by selecting option Schedule > Show Rule 

Violations. Any violations will appear as names in red and if you click on them the 
reason will also be given. 
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Smart Explain  

A question often raised is “why won’t SmartRoster schedule so-and-so to a 
particular role or timeslot?”. Now you can find out why. Just try dragging the 
persons name into a timeslot. SmartRoster will show the reason why a person 
cannot be allocated in a small text box next to the mouse cursor. 

 

Using the “Dates by Names” grid format 
To select this format, choose menu Schedules > Grid format and select 
Dates by Names from the menu. Choose menu Roles by Dates to go back to 
the default format. 

This alternate grid format has individuals as rows and the event dates as 
columns. It shows roles (using role abbreviation if supplied) as values in the grid 
cells. This format is especially useful where a majority of individuals are 
scheduled many times within the schedule period. It it not as useful where you 
have a large number of people who are scheduled infrequently. 

While using this format note the following: 

1. You cannot enter cell comments 

2. You cannot schedule people by drag-and-drop 

3. You can select from a persons eligible roles by the right-click menu 

4. Locking a row (person) is equivalent to de-activating a person 

5. Locking a column (event occurrence) is equivalent to locking a row in the 
default “Roles by dates” grid format  

6. The Date format specified may be different to the date format used in the 
default grid format (SmartRoster remembers both settings) 

7. The following comments regarding locked entries only apply to the default 
“Roles by dates” grid format. 
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Locked Timeslot Entries 
You may manually allocate some or all events for a role (such as the Speaker 
role for a Church Service, which would rarely be automatically allocated) and you 
may even allocate all roles for some events (like a special memorial service or 
holiday).  SmartRoster allows you to lock in a whole column (role), row (event 
instance), or cell at a time, or person in a cell. When you lock a person, row or 
column, a small lock symbol will appear and the cell, row or column text will 
change to grey text. You will need to unlock it if you wish to make changes to it. 
The Auto Scheduler will not re-allocate cells that are locked. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Schedule Comments 
To add a comment into any timeslot, right-click over the timeslot. The select  
“Add Comment” from the right-click menu. Type in a new comment or select 
from the list of previous comments from the drop down box (see diagram 
above). Alternatively simply double click into any blank area in a cell. 

You cannot enter comments while editing in the “Dates by Names” grid format. 

To lock a row:  
Click once in the 
top-left of the 
header cell of the 
row (the cell that 
has the event 
date/time and 
name). A lock 
symbol will 
appear. The 
whole row’s text 
will appear 
greyed out 

To lock a single person:  
Click just before a person’s name to lock that 
person in at that position. A small lock symbol 
will appear. The Automatic Scheduler will not 
change this allocation 
 

To add a comment  into any 
timeslot select  “Add 
Comment” from the right-
click menu. Type in a new 
comment or select from the 
list of previous comments 

The right-click menu 
also lists the names of 
all individuals that are 
available for allocation 
in this cell. Select a 
name to put that name 
in the cell 

To lock a column:  Click once immediately to 
the left of the header cell of the column. This will 
be the cell that has the Role name in it. A small 
lock symbol will appear. The whole column text 
will appear greyed out 

 

To lock a cell:   
Right-click on any cell and select 
“Lock Cell”  from the menu OR click 
in the top right corner of any cell to 
lock th cell.  
 
Locking an empty cell will prevent 
the Automatic Scheduler from filling 
that cell 

To add an Attendance 
status flag to a person in 
their scheduled timeslot 
right-click and select 
Add Attendance and 
then select the 
attendance flag from the 
menu  
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“Schedules panel” Date and Name format 
You can specify the format of the names or dates that appear on either axis by 
choosing the  Schedules > Name format or Schedules > Date format 
menu respectively. 

By selecting Date format you can specify how SmartRoster displays the 
Event/Date/Time label. This string can contain: 

<EVENT>   A literal token that is replaced by the event name 

<COMMENT> A literal token that is replaced by the event comment, if it exists for this 
event occurrence 

| A single "pipe" character which indicate a new line at this place in the 
event specifier 

Format string Strings of characters that substitute for date and time values.   
See: Date-time format strings on page 120. 

Automatic Schedule Generation 
The previous sections discussed how to assign people one at a time, and how to 
make changes as you go along. The best way to assign people to schedules is to 
use the powerful SmartRoster Automatic Scheduler. This feature really is what 
makes SmartRoster stand out from other scheduling methods. 

Pre-Auto Fill Check List 

Before you use the Automatic Scheduler check that you have all necessary 
information: 

� Have you added all absences? See page 47 

� Have you added association preferences?  See page 46 

� Have you added Household association preferences?  See page 48 

� Have you set usage targets for Role Members, where this is known?  See 
page 59 

� Have you added fixed schedule entries and locked these in? See page 71 

 

Scheduler Quality Measures 

The quality of a generated schedule depends on a number of factors, including 
how many associations it satisfies, how close it comes to meeting usage targets 
(how evenly it distributes roles to role members), how many vacancies are filled, 
and (sometimes) overall how many people are able to be scheduled. 

SmartRoster uses a number of quality measures, which are shown for the 
current schedule in the status bar on the bottom of the SmartRoster window. 

Which quality measure is important depends on your specific circumstances. 
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Vacant 
Slots 

“Vacant slots” are the difference between the number of people required 
in a role/event and the number scheduled in a given timeslot. 

Bottom line:   Try increasing the “Cannot exceed…” property if 
there are too many vacant slots 

 

[AutoFill | Options] Increasing “Cannot exceed..” number will reduce 
Vacant Slots at the expense of increased average usage error. 

Average 
Usage Error  

This is the average error between each person’s usage target and the 
actual usage percent attained. For example, suppose all role members 
have a usage target of 25%. For each individual the actual usage percent 
is calculated and the difference between that and 25% is the Usage 
Error. The average of all usage errors for all individuals is the Avg Usage 
Error.  

Bottom line:   The smaller the error, the better th e schedule.  

Association  
Satisfaction  
Score 

This number represents the degree to which association preferences 
have been satisfied by the schedule. It is not simply a count, but is 
weighted by the strength of an association that has been satisfied.  

Bottom line:   A  larger number represents a better the schedule.  

Participants  

This number shows how many people are scheduled at least once in the 
current schedule period. If a person is not scheduled but their family, or a 
group to which they belong, is scheduled, then they are still counted as 
participating in the schedule. 
 

Variability 

This number represents the cooefficient of variabiltiy. Low variability 
occurs when the spacing between scheduled timeslots for a person is 
always the same. High variability occurs when the spacing between 
scheduled timeslots for a person is very variable (sometimes short 
sometimes long). In general most schedulers aim for low variability – 
which also corresponds to a more even predictable schedule. 

Bottom line:   The smaller the variability, the bet ter the schedule.  

 

How the Automatic Scheduler (AutoFill) works 

When you use the Automatic Scheduler, you choose which quality measures to 
try to improve, and in which order.  

Each time AutoFill generates a schedule it compares the quality measures with 
that of the previous best schedule, in the order (top to bottom) shown in the 
optimisation box (below).   

If a schedule improves on any measure then it becomes the current best and the 
optimisation measures lower down the order are not evaluated for that schedule 
(even though they may have become worse). 

If a schedule gets worse on any measure then it is discarded and a new schedule 
is generated. The previous best schedule remains the current best schedule. 

If a schedule is the same (not improved but not worse) on any measure then 
AutoFill continues comparing measures by checking the next selected measure to 
optimise from the optimisation box. 
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In this way it will keep generating schedules, only keeping those that are an 
improvement over any previous. It will keep doing this until it reaches a limit 
(Terminate When.. condition) specified by you when you initiate AutoFill.  

 

Initiating Auto Fill 
To automatically assign people to all of your roles, select Auto Fill  from the 
Schedules  menu. SmartRoster opens the Auto Fill Options dialog box, which 
presents options for setting the Auto Fill priorities and end point (when to stop). 
The Automatic Scheduler then automatically tries to fill all timeslots, except slots, 
roles, and/or events that are locked. If necessary, you can then make any minor 
adjustments and changes you want, and hand out your schedules. It is that 
easy!  

Auto Fill is started by selecting Auto Fill  from the toolbar or the Schedules > 
Auto-fill  Menu. 

The Auto Fill Parameters dialog will be displayed: 

Optimisation  

Place a tick next to any measure 
you wish to optimise. 

Measures higher in the list are 
optimised before measures 
lower  the list. You can order the 
list by using the up/down arrows 
to the right. 

Reduce Vacant Slots instructs Auto 

Fill to seek the lowest possible 
number of Vacant Slots. 

Optimise for Usage Targets tells 

Auto Fill to seek the lowest possible 
Average Usage Error. 

Optimise for Association 
Preferences tells Auto Fill to seek 

the highest possible Association 
Satisfaction Score. 

Increase Participation tells Auto Fill to seek the highest number of participants. 

Terminate when…  

Auto Fill  will keep generating schedules until any one of these conditions is met 

(see table below).  

 

Terminate Condition Means stop generating schedules when… 

Iterations exceed x schedules have been generated 

Time Exceeds x schedules have elapsed 

No improvement after no improvement in the optimisation measure/s 
has been made after x iterations 

Quick Fill  

The Quick Fill (Function key F9)  button is useful if you want to perform just one 

generation of a schedule, then check it manually. Quick Fill does not iterate or 
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attempt to improve quality measures. However it will still usually generate a 
reasonable schedule. 

AutoFill Options 

Selecting the Options button will show the AutoFill options dialog (page 123). 
You can then specify: Look-back days (see page 70), Global enforced breaks. 
Also on this page you can select “Role order”, and “Advanced settings” (see 
below). 

Specifying the AutoFill role order   

The Automatic Scheduler will assign all time slots not already assigned and 
locked in. It will attempt to satisfy as many associations as possible while also 
meeting usage targets and role requirements (how many positions in each role). 

The scheduler fills the schedules in the 
order you specify by selecting the 
Schedule | Set Auto Fill Order menu, or 
click Role Order in the AutoFill tab of the 
Options dialog.  

The following dialog displays. 

Select a role (by clicking on it) and use the 
up and down buttons to change the order 
of the list of roles.  

SmartRoster fills the schedule in the order 
specified (from top to bottom).  

In practice it is best to put the most 
critical roles (important roles or those 

with the most constraints or least role 
members) higher in the list. 

Note, AutoFill order does not effect the 
order in which roles display or print out. 
The display order can be changed by drag-and-dropping the columns in the 
schedule grid. 

Tick “Use random role order" to tell the scheduler to randomise the role order. 
You may wish to do this if you are unsure which role order will generate the best 
schedules. If you also tick “Remember best random order” then SmartRoster will 
save the order of the roles for those schedules it keeps. 

 

Advanced AutoFill settings   

Note! 

In general you should not need to alter any of these settings to obtain an 
acceptable schedule. However, some users will have different needs that the 
settings “out of the box” do not meet adequately. In this case you may find 
changing these settings produces a better match for your organization. 
 

Advanced settings gives the user access to parameters that effect the way 
SmartRoster selects role members for a timeslot from those available to fill the 
slot.  

When selecting a person for a timeslot, SmartRoster iterates through the list of 
all potential occupants (based on the role members AND the availability of each 
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role member for that particular timeslot). SmartRoster compares each potential 
occupant with every other potential occupant. Depending on the parameter 
being compared, it will choose the person who has the: 

• Best (highest) combined score  

• Highest target percent 

• Least times scheduled for role (including the look back period)  

• Least recently scheduled date 

• Lowest number of possible events they can fill 

• Not selected in scheduling period 

• Least times scheduled (all roles) 

• Least times scheduled for role (not including the look back period) 

• Best (highest) usage score 

These tests are called "occupant selection heuristics" and are simply rules-of-
thumb applied to quickly choose between two people. In most cases, using them 
greatly decreases the time SmartRoster takes to find a reasonable solution. You 
can have SmartRoster ignore these completely by unticking the box. This may be 
required in your case if the number of Unique Scores in the Build Progress box 
stops increasing regardless of the number of iterations performed. 

The tests are applied in the order specified in the Advanced settings. A test that 
is not ticked is not used. If the two being compared have the same value being 
tested (eg, combined score) then the next test is tested. As soon as one or the 
other of the pair satisfy a test then they become the preferred candidate and 
they are compared to the next potential occupant until all potential occupants 
are tested. 

By changing the order of these tests, and/or enabling or disabling them, you can 
change the way SmartRoster selects individuals for timeslots.  

For instance, to make sure that everyone is scheduled at least once before 
anyone else is used for role, move the test “6. Not selected in scheduling period”  to the 
top of the list and tick it. This means that anyone who has never been scheduled 
in the current period for a role will be selected in preference to potential 
occupants that have been used at least once, but after everyone has been used 
once then the other tests come into play. 

The “Combined score” is the most important calculated parameter and includes 
the usage score (which reflects the difference between actual and desired usage) 
and a score that reflects associations – such as keep-together, keep-apart, or 
event priority associations.  

Randomise Weighting  

If Randomise weighting is checked then SmartRoster will randomly change the 
weighting between the usage score and the association score between different 
builds of the schedule. 

Pref. Score Exponent (PSE)  

This is the exponent (when divided by 100) to which the initial association score 
is raised to generate the actual association score.  

i.e.  actual association score = initial association scor e (PSE/100)
  

eg. If PSE is   200  then: actual association score = initial association scor e 2 

This allows you to accentuate or diminish the relative significance of association 
scores when calculating the combined score for a potential member. 
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If the foregoing is meaningless to you then you should just leave these settings 
at their default values. 

 

Starting the Optimiser  

Once you have set these Auto Fill  options, click Start  to begin generating 
schedules. 

The Auto Fill progress dialog is displayed which indicates progress of the 
Automatic Scheduler. You can stop it at any time by clicking the Stop  button. 

The Limits  area indicates the terminate conditions that are currently active. The 
Best Scores  area shows the best quality scores achieved so far.  

 

 

Post Fill Review 
A number of tools are provided to help you review the quality of your schedule. 

View current Scheduler Quality Measures 

As already discussed on page 75, the Status bar contains performance measures 
for the current schedule (make sure View > Status bar  is checked on the menu). 

 

Show Usage  

You can see how many times a 
person has been allocated to a 
specified role by selecting Show 
Usage from the Role menu. 

This will display extra columns 
in the detail view of the role members list (select Detail view from the Role 
members context menu). The Used  column shows how often as person is used in 
the current scheduling period, while Used(+LB)  shows how often they are used in 
the current scheduling period PLUS the look-back period. 

You can also see how many times a person has been allocated across all roles by 
selecting Show Usage  from the People  menu. This will display the number of 
times used next to each persons name in the People panel. Note this only counts 
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people scheduled in the current period – not in the look-back period, if this is 
set. 

Where is this person? 

As you move the mouse 
pointer over the schedules 
grid, it will highlight in yellow 
the name of the person 
currently under the mouse 
pointer wherever that name 
appears on the schedule grid. 

You may like to close the 
People and Events panels and maximise the SmartRoster window when 
reviewing the schedules. 

Also you can double click on a person and select the Scheduled tab to see a list 
of their scheduled timeslots  - including in the look back period if set. 

Why couldn’t this person be assigned to a timeslot?  

Try to allocate a person manually, and SmartRoster will explain (in the status 
bar) why it would not allow an allocation. 

 

Common Problems 

Some people are scheduled too often and some people  not at 
all! Why is this? 
There are many reasons why this can happen.   

A common reason for this is that the people without a usage target (the non-fixed role-
members) are being scheduled too often (usually linked to association preferences).  

SmartRoster provides a setting that allows you to determine how non-fixed role members 
are treated during scheduling once they have reached the internal target that SmartRoster 
automatically calculates for them – the non-usage targets. Under AutoFill | options, the 
setting Cannot exceed calculated role member target by more  than… allows 

SmartRoster to exceed this non-usage target by a set amount. The higher this tolerance, 
the more flexibility SmartRoster has to fill vacant slots. The lower this tolerance, the more 
likely that role members will be used evenly – at the expense of vacancies. This setting 
does not effect role members with a usage target, or individual usage targets (those set 
for a person outside of a role). 

So, the reason that some people are scheduled lots more than others is that you have 
allowed SmartRoster to exceed the non-usage target by setting Cannot exceed 
calculated role member target by more than… to a high value. In practice we suggest 

you set this to a low value (0 or 1) and run the scheduler, then increase it by increments 
of 0.5 or so, until vacancies are acceptable. If this requires some people to be scheduled 
too often this usually means you don’t have enough people in those roles. 

Another reason some people are not scheduled at all, or much less than their target (as 
shown in the role members panel), is that they may be over-constrained. They may have 
absences, they may be involved in an “Always keep together” association preference with 
their family or other individuals which cannot be met, or possible they were scheduled too 
many times the previous period and SmartRoster is therefore is not using them this 
period. 
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A good way to see why a person is not being utilized is to try to manually schedule the 
person (drag their role member record over the role timeslots). As you drag SmartRoster 
will show in the status bar the reason why they cannot be dropped. 

Why are there so many vacancies? 
SmartRoster calculates targets for each role member (those without a usage target) in 
such a way that there will be no vacancies, and everyone is used roughly the same 
number of times. The reason vacancies exists is that 

1. you don’t have enough people in a given role 

2. you have too many associations – such as families that must be scheduled together, or 
individuals with mandatory associated preferences, or too many people with a restrictive 
usage target. 

You can reduce the number of vacancies by allowing SmartRoster to use people above 
their non-usage targets. These are the targets that SmartRoster calculates for role 
members who do NOT have a fixed target specified. Under AutoFill | options, the setting 
Cannot exceed calculated role member target by more  than … allows SmartRoster to exceed 
this non-usage target by the set amount. The higher this tolerance, the more flexibility 
SmartRoster has to fill vacant slots. The lower this tolerance, the more likely that role 
members will be used evenly – at the expense of vacancies. This setting does not effect 
role members with a usage target, or individual usage targets. 

A particular role member has a usage target of “Avg  1 time per 
month”, but some months they are scheduled twice in  a row 
and some months not at all! Why is this? 
If you have selected "Average over whole schedule" when you set up the usage target for 
this role member, or for this person, SmartRoster will try to scheduled that person such 
that they average their fixed limit over the whole schedule-plus look-back period (the 
planning horizon).  So, if the planning horizon is, say, three months, the person should be 
scheduled three times in that period. This could be three times in the first month and 
nothing in the other two, or once in each calendar period. While SmartRoster will try to 
space it out as evenly as possible, availability of other role members may mean that 
SmartRoster has to choose this person twice in a short period. Satisfying association 
preferences is another common reason why this happens. 

If you actually mean that this person should be scheduled a Maximum of 1 time per each 
calendar month (with the first month starting on a given date) then you should select 
“Maximum for each month” in the appropriate drop down box when setting that person’s 
Usage Target (under the Update Person Details dialog – not the role member dialog). In 
this case don’t use a role-member usage target for this person. 

They may still be scheduled back to back if they are scheduled at the last week in one 
month and first week of the next. Another option is to use the enforced break feature for 
them. If you define an enforced break for a role member then this guarantees the break 
between timeslots within that role for that role member. If you use an enforced break for 
an individual (not a role member) then the enforced break will be guaranteed between 
timeslots for that person regardless of the role. 

Finally, to determine a regular repeating pattern at which a person is scheduled you can 
use a pre-assignment for them. This sets exactly the pattern at which they should be 
scheduled (eg the first Sunday of every 2 months, or every second Thursday). This can 
also be set for either a role member (applying to a single role) or to an individual, 
applying to a group of roles or to all their roles. 

If you wish everyone to have a certain guaranteed break between scheduled timeslots 
then use the global enforced break (set under menu Schedule | AutoFill). 
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Exporting and Importing schedule data 

Exporting schedules from SmartRoster   

Select “Schedule > Export > As Importable data” from the main menu to export 
the schedule information only in a format that SmartRoster can import.  

You will see the following dialog: 

 

Select the dates, Roles, and Events from which you wish to export the schedule 
data. You will be asked for a filename for the export file. Enter a name and click 
OK and the schedule data will be saved into this file. 

Importing schedules into SmartRoster   

To import this data into the same or another SmartRoster file, Select “Schedule 
> Import” from the main menu. You will be asked for a file to import. This will 
be a file previously exported using the “Export > As Importable data” function. 
Nominate a file and click OK.  

SmartRoster will then import this schedule data into the current schedule. It will 
ignore any schedule data for persons, roles, or events not already in the file into 
which it is being imported. It will NOT overwrite any schedule data already in the 
SmartRoster file into which it is being imported. If you wish to REPLACE existing 
schedule data, use the “Schedule > Clear” function within SmartRoster before 
doing the import.  
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Exporting the finished schedules to other programs 

The finished schedule, as it appears in the Schedules panel, can also be exported 
in either comma-delimited text format, or as html format.  

You can export your schedules in tab-delimited format for importing into other 
packages (such as Microsoft Excel or Word). 

1. Select the Schedule > Export  menu. The following dialog box will display: 

2. Select the desired type of format to export: 

� To save as Tab delimited format select "Tab delimited text format" in "Save as type" box. 

� To save as html format select "HTML format" in "Save as type" box. 

3. Type in the name of a file to export to and click “Save”. 

You can also export schedules in SmartRoster SRP, Acrobat PDF format, and 
Windows WMF, and into MS Word (2000 or above) via the reporting function. 
See page 97. This provides considerably more options regarding layout. 

 

Importing an html file into MS Word 

To import an HTML file into MS Word, use the "Insert | File" menu. 

Importing a Tab delimited file into MS Word 

The following is a guide to importing a Tab delimited file into MS Word (the 
following commands apply to MS Word): 

1. Start a new document in Word (Select menu "File | New Document") 

2. Optionally select menu "File | Page Setup" and set the margins to one inch or 
less, page layout landscape  

3. Select menu "Insert | File" and select the *.txt file you exported in tab 
delimited format 

4. Select all text and do "Table | Convert | Text to Table". In the dialog select 
"Auto fit to contents" and "Separate text at Tabs" and OK 

5. Optionally change the font as desired (eg Arial 8 point fits more on the page) 

6. Select menu "Edit | Replace" and replace ";" with "^l"  (without the quotes) 

select "All" in Search options, and click Replace All 
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Attendance monitoring and reporting 
Attendance allows you to define historic attendance status flags, and to set and 
report how the persons scheduled performed according to the published 
scheduled. 

Defining Attendance status flags 

To define your Attendance flags, select File | Options and select the Other tab. 

The bottom panel is called “Attendance status (one per line)”. Simply type each 
Attendance status you wish to use, one on each line. 

Eg.  

 

 

Click OK to save the list. 

Setting personnel attendance for historic schedules . 

Make sure the Schedules panel is visible. 

Right click on any person in any role and select “Add Attendance”. This will show 
the  Attendance status flags you created in the first step. Simply select one of 
these. You will notice that a small red “A” appears next to the name of that 
person in the Schedules panel, indicating to you everyone who has an 
Attendance status attached. 

Reporting Attendance status 

1. Select Inventory from the Report menu. 

2. Select “Attendance” in the Report Type drop down box. 

3. Select the rest of the items you wish to see on the report, especially the 
persons, roles, events, and dates. 

4. Click OK to run the report.  

This report will have a single column for each Attendance status you defined. It 
will also have a row for every person you selected to report on in the Report 
Parameters dialog, with totals for each Attendance status at the bottom of the 
report. 
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C H A P T E R 6  
Reports 

    

     

    
How do I 

generate reports? 
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Introduction 
The most important report generated by SmartRoster is the Master Schedule 
(see below) or the Individual Schedule. You can send out a single master copy or 
have SmartRoster generate a personalized version for each person or household, 
which has the person’s name highlighted on the schedule. 

Report Types 
 

Schedule reports Individual Schedule Prints only an individual's scheduled roles, for each 
recipient 

Event per page Prints a schedule for each occurrence of each 
selected event on a separate page 

Role per page Prints a schedule for each selected role on a separate 
page 

Master Schedule Prints all selected roles, for each recipient 

Master II Schedule Prints all selected roles, for each recipient 

Calendar View Prints each month on a separate page in a standard 
Calendar format 

Address book 
reports 

Household Directory  Prints the address book report 

One-line directory  Prints the address book – one line per person 
 

Label reports Mailing Labels Reports addresses in a grid format suitable for 
printing directly onto mailing labels 

Reminder Labels Reports each selected individual’s schedule in a grid 
format suitable for printing directly onto mailing 
labels 

 

Inventory 
reports 

Role Inventory A summary report of each role’s data, including 
contact, events and compatible roles, and role 
member data 

Personnel Inventory A table of user-selected columns reported in a handy 
table format suitable for copy and pasting into other 
programs such as Word or Excel   

Role Members Prints a list of persons available in each role/event
   

Analysis reports Role Distribution Shows how many times each person is used in each 
role 

Event Distribution Shows how many times each person is used in each 
event 

Distribution Summary Shows number of times scheduled in each event/role 

Attendance Shows all attendance counts by person by 
attendance flag 

Association Satisfaction Shows for each association whether number of times 
kept vs not kept 

 



CHAPTER 6  
Repor ts  
 

 

88 

Report Parameter Entry dialog 
To create any of the schedule reports choose Schedules  from the Reports 
menu. 

The Report Parameters window will be displayed.  

 

 

 

Select the report type 
(see table below) 

Choose a format 
for the dates that 
appear in the 
schedule 

Choose the 
format for 
People’s 
names  

Name the report 

 

Select <Master 
copy> to generate 
one copy without 
any highlighting of 
recipients' names  

 
A copy will be 
generated for each 
person or household 
selected here.  
 
  

Select the 
events to 
include in 
this report 

Select the 
Roles to 
include in 
this report 

Retrieve named reports Delete named report 

Hide event 
name from 
reports 

Drag here 
to resize 
the Event 
list panel 

Define an advanced 
filter to limit the 
people you see  

Set the page 
size, margins, 
units  

Resize fonts 
globally  

Change max 
columns that 
can be printed 
across  

Set the paper 
orientation 

Choose properties 
(fields) to report for 
Personnel report  

Only options relevant to this report will appear in 
this check list box. 
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Report Title This title will appear on the header of each page of the report. All the following settings 
will be saved with the name of the report you type in here. 

Report Type See above 

Name Format The format in which names will appear in the schedule (eg, only preferred names, First 
name and last name) 

Date Format The format in which event occurrences will be labelled (the first column in the schedule 
grid) 

Select People 

Individuals Print one copy of the schedule for each selected individual, 

highlighting anywhere that the individual is scheduled  

Households Print one copy of the schedule for each selected household, 

highlighting anywhere that any person from the household is 
scheduled  

Each member of  Print one copy of the schedule for each individual in the 

selected selected households, highlighting anywhere in which  

households that individual is scheduled 

Select Events Exclude from the report any event not selected 

Select Roles Exclude from the report any role not selected 

Paper settings 

Size Set the size of the paper 

Margins Set the non-printing margins (in the units selected in “Units” 

Units Set the Units to use for margins (Centimetres or Inches) 

Columns Set the number of columns to lay out on a single page. Effectively 
allows multiple logical pages per physical page 

Orientation Set the way the report is printed on the page. Portrait means print 
across the narrowest dimension. Landscape means print across the 
broadest dimension. 

Multiply all font 
sizes… 

Set this value to change the default size of fonts. The relative sizes are not changed 
(such as the size of the title font compared to the table text), but this changes ALL fonts 
by the factor you enter into the box. Less than 1 will cause all fonts to shrink. Greater 
than 1 will expand all fonts. 

Max table cols 
For a number of reports this item allows the user to specify the maximum table columns 
to report. SmartRoster will then split the table over a number of pages if necessary to 
display the report using no more than the specified number of table columns. 

Report 
Measure 

Some analytical reports allow the user to specify which measure to report: Count, 
Hours, or Cost. 

Create PDF 
If you wish to save the report in PDF format (say, for sending to someone else, or as a 
permanent copy) you can tick this checkbox. Keep in mind that this will slow down 
report generation.  

Hide dates..  Hide dates (event occurrences) not applicable to the recipient of the report 

Print roles on 
vert axis 

For certain reports this allow you two switch the axis so that role go down the page 
instead of across. This may allow the report to fit better on the page. 

Hide names..  Hide names of people other than the recipient (or members of recipients family) 

Show 
Attendance 
columns 

This options applies to the Event-per-page report. It adds a column for each attendance 
flag you have defined. You can then use the report as a sign-in sheet for the event 
coordinator to use to indicate the attendance status of each person scheduled for that 
event. 

Collate pages 
for Booklet 
style 

This options applies to the Address book report. This setting causes pages to be 
generated in the correct order for printing booklet style reports. This means: 
landscaped, two columns per page, printed on both sides, placed on top of each other 
and stapled in the middle. 

Show Contact 
List 

Some Schedule reports will optionally print a contact list with the report showing all 
those scheduled in the report, together with their contact phone number 

Combine 
events 

Click this option for Master II report, will report all events on the same date in a single 
table column with the event name and time prefixed 
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Advanced Filter 

An filter button allows you to show only that people records that match selected 
attributes from your people records. You can apply a filter to the People panel in 
the main window, or to any report in the Report Parameters dialog. 

Fields that can be filtered include: Address, Age, Cell phone, Email, Events, Fax, 
Fixed Phone, Fullname, Groups, Notes, Postcode, Preferred Name, Roles, Sex, 
State, Surname, Title, Town. 

Click on the Filter in the Report Parameters or Group Members dialog or F button 
in the People panel to activate the Advanced Filter dialog box. 

SmartRoster also remembers previous filters you have used and you can select 
one of these by clicking on the down arrow next to the filter text box. 

 

This example shows a filter which will only select people records for those less 
than 15 years old with postcode=77544 who are male. 

To create a filter: 

1. Select an item from each drop down box, or type in a value (in the 3rd drop 
down box) 

If you have chosen "Matches" in the second drop down box, you can type in a pattern into the 
3rd box. The pattern can contain any number of characters or digits and you can use * to match 
any string(or nothing) and use ? to match any single character. For instance, to find everyone 
whose surname starts with "J" enter the patters "J*" into the 3rd box.  

2. click the Add button 

3. To add another criteria, select "and" or "or" then repeat steps 1 and 2 

4. To finish click OK 

To clear a filter (stop filtering): 

1. Click the Clear filter button 

2. To finish click OK 

The filter will be saved with the current report if you are editing report settings. 
When used with a report it will limit the people that may be selected for the 
report to only those that match your criteria. 

To clear the filter history: 

1. Click the Clear History button 
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Schedule Reports 

Master Schedule 

 

The Master schedule format shows all or selected roles, including those roles that 
an individual is not on, highlighting the individual (recipients) name wherever it 
appears. 

Individual Schedule 
 

 
 

The individual schedule shows the schedules for all roles the recipient is required 
to serve. Once again, the name of the recipient is highlighted wherever it 
appears.
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Event-per-page report 

The Event per page report shows all people that are required for all selected 
roles and events on a particular occurrence of an event. 

A single page is printed for each date and time that an event is scheduled.  

Creating a sign-in sheet 

If  "show attendance columns" is ticked, a column for each attendance flag you 
have defined is added. You can then use the report as a sign-in sheet for the 
event coordinator to use to indicate the attendance status of each person 
scheduled for that event. 

Role-per-page report 

This report puts each role report on a single page. It is useful if you have 
different people responsible for each role so that you can give them a copy of 
their own report for review or feedback. 

General Purpose Master Copy  

You may wish to print a copy of the schedule without specifying who it is for 
(say, to keep a number of spares, or to photocopy), that is, a copy not 
highlighted for any specific individual. To do this, when entering details in the 
Schedule Reports  window, select "<Master Copy>" as one of the report 

recipients in the "Select merge recipients" panel. 

“New File” wizard on new files 

 

Inventory Reports 
To create any of the Inventory reports choose the Reports | Inventory menu. 
Inventory reports are provided to make review of all the individual and role data 
easier, especially where more than one person is responsible for this data. These 
reports are useful for verifying personal, role, or role member information prior 
to each scheduling cycle. 

Personnel Inventory 

The personnel inventory provides a concise summary of all information contained 
in the SmartRoster file regarding each person. It is formatted as a person-per-
page report and can be conveniently emailed to each individual for their 
verification of errors or changes to associations. 

Role Inventory 

The role inventory report conveniently summarises all information currently 
contained in the SmartRoster file for each role in turn. It is formatted as a role-
per-page report and can be conveniently emailed to each Role coordinator (if this 
is provided for a role) for the coordinator’s verification of errors or changes.  

Role Members 

The Role Members report provides a separate page for each combination of Role 
and Event. It is a useful contacts list for distributing to each person in the 
Role/Event combination.  
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Address Book Report 
The address book report is available by selecting Address Book from the 
Report menu. 

An example is shown: 

 

The usual format is a landscaped page with two columns per page. This is useful 
for producing booklet-style address books for your organization.  

You may prefer to print it in a one-column-per-page portrait layout format and 
use a duplexing printer or photocopier to produce the final reduced 2 pages-per-
page double-sided booklet style output. 

You cannot publish this report to Word. 

To print a booklet with a single sided printer 

1. Select Report  > Address Book ; 

2. Make sure Report Type is set to “Household Directory”; 

3. Set the page size to A4 or Letter (or similar); 

4. Tick the box “Collate Pages for booklet style printing” (This automatically sets 
the page orientation to Landscape and the Columns to 2) and click OK 

5. Click the Printer icon 

6. Select Even pages 

7. Click OK 

8. Now turn the printed pages over and reinsert them; You may need to 
experiment with whether to reverse the page order before reinserting them 
into the printer tray. Note: some printers do not print well on pre-printed 
paper.  

9. Repeat from step 5, but this time print the odd pages.  



CHAPTER 6  
Repor ts  
 

 

94 

10. Lay all pages on top of each other in the appropriate manner so that when 
folded in half they page correctly according to the printed page numbers. 

Analysis Reports 

Role Distribution 

The Role Distribution report shows how many times each person is scheduled in 
each role. By selecting only certain events you can also show how many times 
people are scheduled to specific events. The report also shows the target against 
which SmartRoster is trying to allocate people. The target is only shown if you 
select the full scheduling period – including the look-back period, since the 
targets always include any look-back period set.  

Attendance 

If you have created attendance flags and assigned these to people in the 
schedule then you can report against each person how many times they appear 
against each attendance flag. 

Association Preference satisfaction 

The Association Preference satisfaction report shows you the degree to which 
association preferences have been satisfied. While SmartRoster tries to satisfy as 
many as possible, it is usually not possible to satisfy all of them. This report 
shows exactly who has, and who has not, been able to be accommodated. 
Columns include: 

Constraint   Always together, Always apart, etc 

Together  The number of times the people in an association group are all on 
together 

Apart  The number of times the people in an association group are NOT all on 
together 

% Together  The average percent of persons in the association group that are 
scheduled together (useful for families or groups) 

Violation  If a rule violation exists: may be blank, Minor, or Major. A Major rule 
violation is when the constraint is Always together or apart and this is 
not strictly kept. 

 

Printing Labels 

Mailing Labels 

To produce mailing labels select Labels from the Report menu. Then select 
“Mailing Labels” in the Report Type drop down box if not already showing. 

An example is shown: 
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A typical format is a portrait layout with two or three columns and 10 rows per 
page. The number of rows and columns is configurable. Use the paper settings 
to change the margins, rows, and columns to fit your preferred label size. 
Remember to change to Report Title to save your settings. 

Reminder Labels 

Reminder labels are useful for attaching to mailed out pieces. These are similar 
to the email reminders, but of use with those who do not have email. 

To produce mailing labels select Labels from the Report menu. Then select 
“Reminder Labels” in the Report Type drop down box if not already be showing. 

Now select the date range for which you want reminders printed. 

An example is shown: 

 

 

 

SmartRoster Viewer 
The SmartRoster Viewer is the program that allows you to preview and print 
reports. You can also save reports to the SmartRoster Print Document format 
(*.srp) or individual pages can be saved in Windows Metafile format (which can 
be inserted directly into MS Word and some graphics programs). When the 
SmartRoster viewer is being run from within SmartRoster, reports can also be 
saved in Adobe Portable Document Format (pdf). 

You can also publish a report directly into MS Word (currently only tested for 
Word 2000), which allows you to then edit the report before printing it.  

Click OK in the Schedule Reports window to build the report and preview it in 
the SmartRoster Viewer. You will see the following window. 
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The Viewer Toolbar 

The functionality of the viewer is available by selecting icons in its toolbar. 

 
Open a report that has previously been saved in srp format.  

 
Save the report as SmartRoster printout or windows metafile 
format 

 Zoom in (increase the magnification) 

 Zoom out (decrease the magnification) 

 
View at full size 

 
Fit the whole page in the window 

 
Fit the page width in the window 

 
Print the report 

   
Move to the previous/next page 

*  Email the report to all recipients who have an email address (see 
page 100) 

*  
Use the Adobe Acrobat Reader to view the report (where this is 
installed). This also allows the report to be searched. 

*  
Publish the report into Microsoft Word 2000 or above (see next 
section) 

  
Publish the report to a Web server 

 
Copy the contents of the displayed report to the clipboard 

 
Close the SmartRoster viewer 

* Note: these options are only available where the viewer is being run from 
within SmartRoster itself. Other users accessing SmartRoster reports (srp files) 
using the Viewer will not see these options 

Copy to Clipboard  copies the text from the displayed report in a tab-delimited 
format into the Windows™ clipboard, ready to be pasted into any application of 
your choice, such as MS Excel or MS Word. This may be especially useful for 
those with earlier versions of Word, for which the “Publish to Word” option does 
not work. 

 



Repor ts  
  

 

   97 
 

Publish Report To MS Word 
The Publish to Word button attempts to re-create the report in MS Word. This 
button will only be visible if you have some version of MS Word installed on the 
computer on which you are running SmartRoster. 

This functionality requires MS Word 2000 or higher. This means it may only 
partially work (or not at all) on earlier versions of Word. 

Note: The interface between SmartRoster and MS Word is quite slow. A report will 
typically take 10 to 50 times as long to render the report in Word as it does in the 
SmartRoster viewer itself.  

The address book report cannot be published to Word in this way. 

Publish Report to Web server  
The Publish report to Web server button will allow you to upload the current 
report in the SmartRoster viewer to your church or organisational web site.  

This is only useful if you have a web site and have FTP user and password to 
upload files to your web site. If you are not sure then contact your Church or 
organisation's webmaster, or contact your web site's hosting ISP and request 
your FTP User Id and password. 

 
 

To access this feature click on the "Publish report" button in SmartRoster viewer. 

This will popup a small dialog in which you can enter your FTP logon details, 
including your website address and the server folder to which your report will be 
uploaded.  

An upload will 
overwrite any existing 
file with the same 
name. You may need 
to create a link 
somewhere within 
your web site to allow 
your people to see 
uploaded reports. You 
can also email a direct 
link to the uploaded 
file so people can 
download and view the 
file. 

 

Options: 

Enable Report Uploading via FTP 

tick this box to enable report uploading.  

Server filename This is the default name of the file to be created on the 
server. You can change this name. 

Web address your FTP server name, e.g:   www.MyChurch.org 

User ID the FTP logon user ID provided by your ISP or webmaster  

Password the FTP logon password provided by your ISP or webmaster 

Port defaults to 21 but you can specify any port to use 

Server path the server path to which you will be connected. Your files 
will be uploaded into this path. Eg:  /httpdocs/schedule 
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Exporting Reports 
You may save a report to a disk file for sending to another person by email or by 
floppy disk or other removable media. 

In the SmartRoster viewer, click the save icon . 

A small dialog will display. You can select from the multiple formats supported by 
SmartRoster by clicking on the drop-down arrow next to the Save as type box 
and selecting a format. 

 

Then select or type the name of a file in the File name box and click OK. A file 
with that name will be created.  

*.pdf SmartRoster can save any report as Adobe portable document format. The end 
user needs Adobe Acrobat Reader software, which can be freely downloaded 
from Adobe's web site at http://www.Adobe.com. In practice many users will 
already have it installed. This format is also useful for publishing to Internet 
Web sites. 

*.emf 

*.wmf 

If you select "Enhanced Metafile" or "Windows Metafile" a file will be created for 
each page in the report, since these formats do not support multiple pages. The 
filenames all start with the name you entered with an increasing numerical suffix 
for each page file. 

  

 



99 

C H A P T E R 7  
Email & SMS 

    

     

    
Communicating 

by Email and 
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Chapter Contents 
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 SmartRoster provides you with a number 

of options for communicating reports, 

reminders, and arbitrary messages and 

file attachments to individuals and 

households via email or SMS. 
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Send Report By Email 

In the SmartRoster viewer select the Email icon  to send the report being 
viewed to all recipients who have an email address. 

Email Settings 

Before you can use the email facility you must enter a number of settings. To do 
this either  

� select the Email > Options  menu, or    

� click the Email Settings button in the Distribution window (the latter will 
display when you click the Email button in the SmartRoster viewer). 

You will see the following options: 

 

 

 

 

 

Email account: This is your email account. Reminders or reports will be sent from this 
account. 

Admin name: This is your email name. This is how the "from" account will appear to 
recipients. 

Auto Send: When creating emails by any method, when you click "Send" they go to the 
Email Queue Outbox. If Auto Send  is ticked, then they will immediately 
begin sending. If Auto Send  is NOT ticked, then you have the opportunity 
to review/edit them before they are sent. 

This is your email account. 
Reminders or reports will be 
sent from this account 

Hostname is the 
SMTP server 
name provided by 
your Internet 
Service Provider 

This is your 
email name. 
This is how the 
“from” account 
will appear to 
recipients. 

Sets how long 
SmartRoster 
should continue 
to try to send a 
message 

If your ISP requires 
authentication, enter 
the details in these 
fields (SMTP default 
only) 

Set the format for attaching reports to email 
messages. Using pdf format requires the 
recipient to have Adobe Acrobat Reader 
installed. Using srp format requires the 
recipient to have the SmartRoster viewer 

Set the 
attachment 
encoding 
format.  Leave 
as the default if 
unsure. 

Set the mail 
protocol to use. 
SMTP (Default) is 
the best if you’re 
unsure 

Select a folder 
on your PC for 
saving queued 
and sent email 
messages 
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MAIL PROTOCOL  

"MAPI" MAPI is appropriate if you use a Microsoft email product (like Outlook).  If 
not sure, try "SMTP (Default)" and if this doesn't work try MAPI. If you use 
SMTP and don't know your external SMTP hostname, try "SMTP 
(Alternate)" . 

 NB: If you use the MAPI protocol your messages will ignore the Email 
account and Admin name specified above and will always be sent by your 
default account as set in Outlook or Outlook Express. 

"SMTP (Default)"  This is the default SMTP gateway. This method requires the External Host 
to be set, and allows for email authentication as required by some SMTP 
servers. It may be more reliable than "SMTP (Alternate)" 

Use External Host:  Always ticked for SMTP (Default) 

Hostname You need to provide the Hostname which is the SMTP server name 
provided by your Internet Service Provider. If unsure you can sometimes 
find this on your ISPs web site. 

Authentication One of:  

> No Authentication (default value) 

> PLAIN. Most SMTP servers support it. However, the password is not 
encrypted during the transfer 

> LOGIN. Nearly all SMTP servers support it. The password is not 
encrypted 

> CRAM-MD5. The password is encrypted and protected from cracking 

> NTLM authentication (also known as Secure Password Authentication). 
Widely used with Microsoft products and services such as IIS SMTP 

> MSN authentication (alias of NTLM). Used with MSN services 

Signon/Password: Used when authentication is required (as specified above) 

Connections Not supported 
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COMMON SETTINGS 
Timeout The amount of time to wait when attempting to send emails. 

Encoding This depends on the recipient email system. Usually the default setting will 
be adequate. Leave as the default if unsure 

Attach Report as Reports can be attached in Adobe pdf format or in SmartRoster srp format. 
Adobe pdf requires the recipient has Adobe Acrobat installed. Because pdf 
is a very common format, recipients are likely already to have this, but it is 
also a free download from the Internet. With the Acrobat Reader they will 
be able to view and print reports.   

Using srp format requires the recipient to have the SmartRoster viewer, 
SmartVue, installed (see page 95 for a discussion). SRP files are very 
compact and can only be read by a recipient who has access to SmartVue, 
thus enhancing data security. 

Email Folder The Email Folder is the location on your PC or local area network in which 
SmartRoster Email Queue subsystem stores emails prior to sending or for 
archival. It also uses this area to keep a local copy of email attachments. 

 

Sending Reports from SmartRoster Viewer 

After clicking on the Email icon in the SmartRoster viewer the Compose Message 
dialog will be displayed. This dialog allows you to compose the message to send 
along with the report, and further limit who to send reports or bulk email, and 
how they are to receive it. The following illustrates: 

 

1. Select the email recipients and whether by email or hardcopy 

� Tick By Email to send them a message. This is only relevant if they have a valid email 
address. 

� Tick By Post to generate a hardcopy report, which you can then send to them by mail. This 
applies for sending reports only (ignored for bulk emails). 
Use the Set All or Clear All buttons to set or clear, respectively, all off the above checkboxes in a 
single click. 

� The address column will show the current email address recorded for a person or household. 

� Type into the Filter box to further limit the names to those that match your filter text 

2. Type in the subject in the space provided (using field codes* if needed). 

3. Attach additional arbitrary attachments if required by clicking on the Add 
button next to the Attach: box (not necessary for the report you generated) 

4. Type in an optional message in the space provided. This message (if any) 
will be attached to the email message to be sent to them. Use field codes* 
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to included information specific to the person being addressed. You can send 
HTML messages by simply typing valid HTML code in here, or by loading an 
external web page by clicking on the “Load web page” button. As long as the 
text included the tags <HTML> and </HTML> then SmartRoster will treat it 
as a web page when sending. 

5. Click “Attach vCalendar reminder” to attach to each each person’s email a 
vCal format file which allows them to easily update their Outlook (or similar) 
calendar by opening the attachments – one for each date scheduled 

6. Click Generate > Email 

� SmartRoster will generate one email message for each person with the By Email column 
ticked, and it will open the Email Queue dialog where you can review the email messages 
generated, delete or modify them, and send them. If Auto Send is selected in the email options 
dialog, the messages will automatically start being sent. 

7. OR Click Generate > Hardcopy 

� SmartRoster will create a report in the SmartRoster Viewer, containing only schedules for 
those for whom By Post is ticked (not available for bulk emails). You can then just print of those 
reports for which hardcopy is required. 

 

* Field codes 

In either the subject or message of the Email dialog you can select Field Codes 
to insert which will be replaced by the actual value for each message created. 
When you click Generate a new email message will be created for each person 
you have selected in the Recipients dialog with "Email" column ticked. For each 
such message the field codes will be replaced by the actual value for that 
person. This provides you with a powerful method of providing feedback to your 
people about data relating to them, such as their addressing, absences, roles, 
events, or schedules. 

To enter field codes: 

First left-mouse-click into the subject or body at the place you want to insert the 
field code - you will see the cursor flashing at this point, called the insertion 
point. 

Then right-mouse-click (click the right mouse button) and you will see a drop-
down menu with the list of possible field codes. Selecting one of them will insert 
that field code into the text at the current insertion point.  

Eg. if you place the field code "[Fullname]" anywhere in the subject line this will 
be replaced, in each email message generated, by the actual full name of the 
person receiving the message. if you place the field code "[Schedule]" anywhere 
in the body this will be replaced by the persons current schedule..  

Possible field codes include:  

PreferredName 
Surname 
FullName 
Title 
Address 
Town 
Postcode 
State 
Fixedphone 
Mobile 
Fax 

Email 
Age 
DOB 
Sex 
Notes 
FixedUsage 
EnforcedBreak 
Absences 
Associations 
Groups 
Members 

Roles 
Events 
PersonType 
Active 
ScheduledCount 
Schedule 
SchedulePeriod 
Organisation 
ReportTitle 
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Sending Bulk Email 
You may send bulk emails including your own message and attachments to a list 
you select from individuals, households or groups in your SmartRoster file. 

To do this select the Email > Bulk email  menu option. This will bring up the 

“Select Recipients” dialog from which you select the individuals/households to 
whom you wish to send a message. You can also select specific roles and/or 
events, to send a message only to people in specific roles. 

Click OK to display the Compose Message dialog (see above). 

You can further remove individual entries by unticking the "By Email" check box 
in the recipients panel. 

Now type in any details you wish in the Subject and Optional message fields 
exactly as you would as per sending a report from the SmartRoster viewer. 
Remember you can also attach files by either typing in their name/s (separated 
by semicolons) in the Attachment field, or clicking the Add… button. 

When you click Generate > Emails  to generate the emails (replacing field codes 

as necessary) and dropping you in the SmartRoster Outbox where the messages 
can be sent 

Sending Email Reminders 
SmartRoster is able to automatically or manually (when you choose) send 
reminders to those people who have an email address. 

To run the reminders module select the Email > Reminders  menu. 

The following window will display: 

 

 

 

 

 

 

 

Click Generate to generate a reminder 
message to each person with a tick 
(and a valid email address) 

Click here to bring up the 
email settings dialog 

Tick this box to select a 
person. Only those with a 
valid email address can be 
selected. 

Tick this box to 
have Smart-
Schedule 
check for 
reminders on 
opening 

Use these 
settings to 
determine 
whom to send 
a reminder to 

This panel shows all 
those due in the period 
specified, even those 
without email. 

Type in an 
optional 
message to 
attach to each 
reminder 

Tick this box to 
ignore previous 
reminders 
(allows you to 
resend them) 
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1. Choose either the number of days to look ahead, or the specific date range 
for determining whom to remind. The Recipients panel will automatically 
update with those due in that many days from now, or within the date range 
specified. 

2. Tick the individuals to whom you wish to send a reminder. (You cannot tick 
those without an email. These people are included in the list for your 
information only) 

3. Click Generate > Emails  to generate the email reminder messages. 

SmartRoster will also start sending the reminders if AutoSend is ticked under 
your email options.  

Automatic Reminders 

By ticking the “Check for reminders…” option, SmartRoster will check for any 
reminders that are due in the number of days specified each time you open this 
SmartRoster file. If reminders are due then this dialog with be displayed and you 
can then click Generate > Emails  to send the reminders or Close  if you do not 

want to do so at that time. 

 

The Email Queue 
Once you send messages, either as bulk email, from within the Report Viewer, or 
as reminders, they will all appear in the Outbox of the Email Queue window. To 
access the Email Queue at other times select menu Email > View Email Queue .  

 

 

 

 

If you have specified “Auto Send” in the email options dialog, then SmartRoster 
will automatically start sending the messages. Otherwise you can revise the 
messages by selecting them from the list and viewing the message in the edit 

Choose between 
Outbox , Sent items , 
and Archive  here 

Click Send to send these queued messages. If AutoSend  is 
ticked under email options, then sending will proceed 
automatically. 

This area shows all 
queued messages waiting 
to be sent, or sent items 
(depending on which view 
is selected) 

If you select a message in the 
queue, the details will display in 
this area, which you can edit and 
update via the update button 
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panel below. You can alter any details of a message before sending by making 
edits in this panel and clicking the “Update” button. 

Right-click on any message in the list to access a popup menu of possible 
options. Options include: 

Edit in Notepad  Open the message (which is a text file) in Notepad 

Re-send  If this is in the Sent Items area, you can re-send a message 
by selecting this menu option. This will move the message 
back into the Outbox where it is queued for sending. You can 
edit the message before actually sending it again. 

Print  To print the text file on a connected printer 

Delete Delete the message (and any attachments it may have) 

Archive  Move all selected messages to the archive area 

All messages that are sent successfully are moved into the Sent Items area, 
which you can select from the View dropdown box (See above). 

The folder on your PC where these messages are stored is defined in the Email 
Options dialog. You should set this before using any of these features. You can 
specify any location on your PC or even on a Network. 

 

 

Sending SMS reminders 

Setting up SMS reminders  

To setup SmartRoster to be able to send SMS reminders carefully follow the 
following instructions: 

1. Purchase a Smartroster SMS activation from our web site at 

www.smartroster.net/purchase.htm  (once-only activation) 

 

(If your support is not current then you will need to purchase support as well) 

Activation includes 100 free SMS credits to get you started. Additional credits are 
available for as little as 10c per text. 

2.  Register the cell/mobile phone number from which reminders will 

originate. To your volunteers it will appear that reminders are coming from this 
number. Their replies will also go to this number. 

To do this, email us your cell/mobile phone number, after purchasing the 
activation.  

Note that this number will NOT be charged for SMS messages sent by 
SmartRoster as originating from it. You need to pre-purchase SMS credits (see 
below). 

You will receive an activation code to this cell/mobile phone. It is critical that you 
immediately forward this code to us at sales@smartroster.net. You cannot send 
SMS reminders without registering a mobile/cell phone number in this way. 

3.  Re-register your smartroster installation with your new registration key 

(which you will receive via email) – just drop the new license file onto your 
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desktop before starting SmartRoster and enter your details into the registration 
dialog and click OK. 

 

4.  Purchase SMS credits from our web site, currently from $40 for 200 

credits, to $100 for 1000 credits (prices subject to change).  Note 100 credits are 
included with your activation. 

 

5. Configure SmartRoster for SMS 

Select menu option File > Options  and the Other tab.  You will see the SMS 
settings: 

 

You should set the Country code to your default country code. This will be 
prefixed to your volunteers cell/mobile phone numbers if they are not stored with 
the country code already. 

NB: You can see how many credits you have available at any time by clicking on 
"Show Credits". 

 

6. Nominate how each of your volunteers will receive reminders. 

Open a volunteers' record (double click the person in People panel). 

 

You will see the new field "Send reminders by'. You can select "Email" ,"SMS", 
"Both Email and SMS", or "No reminders, thanks". Click OK to save the change. 

Of course, make sure your volunteers who choose to receive SMS reminders 
have a mobile phone number specified! 

 

Now you are ready to send SMS Reminders!  
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Using SMS reminders 

To send SMS reminders simply select the Email > Reminders  menu as you would 

for sending Email reminders. In addition you will now also see the following: 

 

 

 

 

 

click 'Generate 
Reminders' to 
generate both 
email (if any 
ticked) and 
SMS (ditto) 
reminders as 
required. 
 

SMS and Email columns in the Recipients grid 
reflect how your volunteers want to receive 
reminders. You can override that preference 
here if needed. This defaults to the options 
set in 6. above "Nominate how each of your 

volunteers will receive reminders" 

This is the SMS reminder message that will 
be sent and is customisable (fields codes 
are replaced of course for each individual 
message) 
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 This chapter will show you how to setup 

login-based security for your Smartroster 

users which implements levels of 

authority and allows users to edit and 

access relevant data while preventing 

alteration to data or schedules to which 

they are not authorised. This is great for 

allowing Role or Role-group coordinators 

or Event coordinators to create their own 

schedules while preserving the integrity 

of data outside those areas. 
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Login Authentication 
Smartroster can be run with or without the requirement for login authentication.  

Login authentication is turned off by default. While security is off anyone who 
has access to the file will be able to turn it on and create logins. Once it is on 
then only a System Administrator (SysAdmin) can add, delete, or change logins. 

Limitations 

Login authentication is not available in SmartrosterLite.  

To turn ON login authentication 

Select menu File  > Options, and tick the checkbox as shown below: 

 

Then click OK to save. 

Now you must create at least 1 system administrator. Right click on the person in 
the People panel as  shown. Select “Edit Credentials” 

 

You will then see the User Credentials dialog as show: 

 

Tick “System Administrator”. Then click “Change Password” to create a 
password.  
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Click Save to save your changes. Now you have created your first system 
administrator (“SysAdmin” for short).  

Now save your datafile (File > Save or click on the save icon on the toolbar).  

From now on this Smartroster datafile will require a user login to open and edit 
the data.  

User Credentials 

The same dialog is used to define all login users for your system. This defines 
exactly what a user can and cannot do with the data. 

System Administrator (SysAdmin) 

This login user (can be more than one) has unrestricted access to all the data in 
the file as well access to changing login user credentials.  

In general, any user who is NOT a system administrator cannot edit details of 
any Event regardless of the permission granted below. They will be able to 
adjust details of Roles to which they have permission to edit but will NOT be able 
to create a new Role nor remove any existing Role. To do this they will need to 
ask a SysAdmin. Also they cannot in general edit the Person details except for 
those persons that are role members for Roles they are allowed to edit. 

The main reason for creating login accounts which are not SysAdmin is to allow 
them to create a schedule for a generally restricted range or roles or even a 
single role, and a restricted range of Events or even a single event, without 
inadvertently or accidentally changing data that may affect other users of 
SmartRoster (for that database). 

Read-only 

Tick “Read-only” to make a login user read-only. They will be limited in what 
they can see by the other elements of the User Credentials dialog, but under no 
circumstances will they be able to make or save changes to anything in the 
Smartroster database. 

Enabled 

Tick “enabled” to enable this user login. The SysAdmin can use this to 
temporarily disable a particular user login without losing the user credentials. 

Change Password  

Click on the “Change Password” button to create or change a password for the 
user. 

 

Hint! 
It is important that 
any person who is 
given user 
credentials to enable 
them to login to the 
Smartroster database 
also have a valid 
email address. This 
email address can be 
used to recover a 
forgotten password. 
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Event and Role restrictions 

 

Finally you can restrict what a login user can see and edit by role and event. 
Typically a user may want to schedule only a subset of Roles but take into 
account the personnel absences and association preferences already entered. In 
this case you can make all roles viewable but restrict which roles they can edit. 
You can also restrict which events can be viewed and which edited.  

(See note above under SysAdmin for further restrictions applied to NON 
SysAdmins). 

A logged-in user will also only be able to edit the personal details for persons 
who are members or role which they are able to edit. 

The SysAdmin can of course view and edit any details. 

Saving the User Credentials 

Once you have created this template save it by clicking “Save”.  You can at this 
point create more user credentials for all the other users who will be logged into 
the Smartroster database. You can come back later if you wish to finish creating 
user credentials. You can also edit user credentials at any time if you are logged 
in as a SysAdmin. Don’t forget to save all your changes with File > Save or 
clicking on the Save icon on the toolbar. 

Guest Credentials 

You can define a set of credentials to be active if a person clicks on “Guest 
Login” in the main login dialog instead of entered a username/password. 

To create Guest credentials select File > Options and click on the “Guest 
Credentials” button (only SysAdmin can do this of course). Set the credentials as 
you would for any other user. Click save to save these credentials (and File > 
Save to update the database). 

Once Guest Credentials have been created by the SysAdmin, the “Guest Login” 
button will be active. If this is clicked then the person will login as “Guest” and 
will be able to see and do whatever is permitted by the guest credentials. 
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Logging into Smartroster 
When you start Smartroster after setting up Login Authentication you will see the 
following dialog 

 

Type in your name or select from the drop-down box next to “User”. After 
selecting a user, you will see the users email below the box as shown: 

 

Click on the email address to have the password for that user emailed to them in 
case it is forgotten. 

Now enter the Password and click Login. If it is incorrect you will have to option 
to try again.  

If Guest credentials have been created by the SysAdmin, then the “Guest Login” 
button will be active. If this is clicked then the person will login as “Guest” . 

If you click Cancel then Smartroster will close the current database and the User 
will be left in a plain empty “untitled” Smartroster application with no ability to 
interact with the data in the datafile. 

Working with Smartroster after logon. 
Once you have logged in you will see your login userid in the bottom left of the 
main Smartroster dialog:  

 

Now you can work with Smartroster as normal. 

If you have restrictions on the Events or Roles you can edit or view then these 
will be evident from what you can see in the various Smartroster views. 

If you are using Smartroster and think that you should be able to edit or view 
something then in the first instance talk to your SysAdmin and request 
appropriate access.  
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If you are a SysAdmin and think that access you have defined it being incorrectly 
applied than contact Smartroster support via the “Help > Email Tech-support” 
menu and we will try to assist you in a timely manner. 

Changing your password 

To change your password after logging in, select 
“Change Password” from the File menu. You will 
see the change password dialog as show: 

Enter your old password followed by a new 
password and re-enter the new password to 
confirm and click OK.  

If you are logged in as Guest OR you are a read-
only user then you cannot change the password. In the latter case you will need 
to request the SysAdmin to change your password for you. 

Reports 

After login authentication is activated, reports that a user creates can be made 
only visible to that user OR are visible to any user. 

This is set in the Report Parameters dialog: 

 

If the box is ticked than all users will see the report definition. If not ticked then 
it will only be available to the person who was logged in when the report was 
created. 

If you are logged in as Guest or are a read-only user then you cannot save new 
report definitions.  
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The SmartRoster Menu 

File 
Page 
Ref.  

New Create a new SmartRoster file 29 

Open Open an existing SmartRoster file 28 

Close Close the currently open SmartRoster file  

Save Save any changes to the open file. If it has never 
been saved, you'll need to provide a filename 

 

Save As Save the open file to a new filename  

Open from web Open a shared file from your WebShare repository 21 

 Save to web Save a file to your WebShare repository for 
sharing with others in your organisation 

21 

Reopen from 

web 

Re-open for update a file previously opened from 
WebShare, currently open in read-only mode 

21 

Options Set SmartRoster Options. You can  

• Set your organization’s name and view your 
current licensing details 

• Configure open and save settings 

• Configure Email settings 

• Configure auto-import  

• Configure AutoFill  

• Configure WebShare 

• Miscellaneous other settings 

 

 

 

 

 

 

 

 

Backup Backup to the current SmartRoster file to 
removable media 

20 

Revert to saved Undo all changes since the last file > save   

Exit Exit SmartRoster  

View 

Toolbar Turn on or off the toolbar  

Status Bar Turn on or off the status bar (the bottom line of 
the main window) 

 

View People Toggle the People panel display 14 

View Events Toggle the Events panel display 15 

View Roles Toggle the Roles panel display 16 

View Schedules Toggle the Schedules panel display 17 

New File Wizard Display the New File wizard (help screens) 29 

Events 

New Create a new event 61 

Edit Edit the currently selected event  

Remove Delete the currently selected event  
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People 
Page 
Ref.  

New Create a new Person 42 

Edit Edit the Person that is currently selected  

Remove Delete the Person that is currently selected  

Show Individuals Change the People panel to display only individuals  

Show Households Change the People panel to display only households  

Show Groups Change the People panel to display only groups  

Display As Change the tabs that appear on the people panel to 
single letter, three letter, household, or no tabs 

 

Import Import people from a tab-delimited format file or from 
another SmartRoster file 

50 

Export Export people in tab-delimited file format 52 

Show[Hide] Usage Hides (shows) the number of times each person is 
used in the current Schedules 

80 

Clear Absences Use this command to clear multiple absence records 
at once 

 

Roles 

New Create a new role 57 

Remove Delete the role that is currently selected  

Order Roles… Move the current role left or right 57 

Pattern Restrict the dates for which the selected role is 
required over the dates for which the roles Events are 
required. The role will normally be required for each 
event in its Applies to events… list. Use this menu to 
remove specific dates/times for this role (you cannot 
ADD dates) 

 

Display as… You can display the roles as a list down the left of the 
role panel or as tabs along the top 

57 

Role Members… 

New Member 

 

Add a new Role Member 

 

58 

Edit Edit the currently selected role members  

Remove Delete the currently selected role members  

Copy Copy the currently selected role members to the 
clopboard 

 

List view Change the Role Members to list view style  

Detail view Change the Role Members to Detail view style  

Name Format Change the format of names displayed in the Role 
Members list, and Schedules grid 

 

Show[Hide] Usage Shows (or hides) the number of times each person is 
scheduled in the role 

80 

Show all members By default the Role members list only shows those who 
are available for the active events in the events panel. 
This causes all members to be displayed. 

 

Role Groups Set up role groups 61 

Restrictions Set up global restrictions  68 
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Schedule 

Auto fill Run the Automatic Scheduler 77 

Undo Undo the last auto fill (revert to the previous schedule)  

Clear… Option to clear all cells that are not locked in the 
current scheduling period, all cells before a certain 
date, or all cells unconditionally 

 

Set AutoFill Order Set the order in which AutoFill will fill role schedules. 
This order can be different to the visible order. 

 

Export Export the schedules as appears in the Schedules 
panel to tab delimited or html formats. 

 

Show vacant slots Turns on or off the display of vacant slots in the 
schedule panel 

 

Post AutoFill review Go to the Post AutoFill Review help page indicated 80 

 

Report 

Schedules Display the Report Parameters entry form to Generate 
various schedule reports 

90 

Address book Generate the address book reports 93 

Labels Generate Label reports 94 

Inventory Generate Inventory reports 92 

Analysis Generate Analysis reports 94 

 

Email 

Reminders Send email reminders 104 

Bulk email  Send ad hoc messages and attachments to a list you 
select from your people 

104 

View Email Queue Manage email messages in the Outbox or review sent 
messages in Sent Items 

105 

Options Set email settings 100 
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The SmartRoster Toolbar 

 
New Create a new SmartRoster file 

Open Open an existing SmartRoster file 

Save Save any changes to the open file. If it has never been saved, you'll 
need to provide a filename 

People Open/close (toggle) the People panel display 

Events Toggle the Events panel display 

Roles Toggle the Roles panel display 

Schedules Toggle the Schedules panel display 

Autofill Run the Automatic Scheduler 

Clear Clear all cells. Provides a small dialog asking you which type of cells 
to clear 

Undo Undo the last auto fill (revert to the previous schedule) 

Report Display the Report Parameters entry form to Generate various 
reports 

Email Send bulk emails to specified lists 

Options Display the settings dialog 
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Date-time format strings 
Date-Time Format Strings specify the formatting of date-time values when they 
are converted to strings. Date Time Format Strings are used in reports and also 
for setting the format of date/time in the main Scheduled Grid (by selecting 
menu Schedules > Date format). 

Date Time Format Strings are composed from specifiers that represent values to 
be inserted into the formatted string. Some specifiers (such as "d"), simply 
format numbers or strings. Other specifiers (such as "/") refer to locale-specific 
strings from global variables. 

In the following table, specifiers are given in lower case. Case is ignored in 
formats, except for the "am/pm" and "a/p" specifiers. 

Specifier Displays 

c Displays the date using the format given by the ShortDateFormat global 
variable, followed by the time using the format given by the 
LongTimeFormat global variable. The time is not displayed if the date-time 
value indicates midnight precisely. 

d Displays the day as a number without a leading zero (1-31). 

dd Displays the day as a number with a leading zero (01-31). 

ddd Displays the day as an abbreviation (Sun-Sat) using the strings given by 
the ShortDayNames global variable. 

dddd Displays the day as a full name (Sunday-Saturday) using the strings given 
by the LongDayNames global variable. 

ddddd Displays the date using the format given by the ShortDateFormat global 
variable. 

dddddd Displays the date using the format given by the LongDateFormat global 
variable. 

e Displays the year in the current period/era as a number without a leading 
zero (Japanese, Korean and Taiwanese locales only). 

ee Displays the year in the current period/era as a number with a leading 
zero (Japanese, Korean and Taiwanese locales only). 

g Displays the period/era as an abbreviation (Japanese and Taiwanese 
locales only). 

gg Displays the period/era as a full name. (Japanese and Taiwanese locales 
only). 

m Displays the month as a number without a leading zero (1-12). If the m 
specifier immediately follows an h or hh specifier, the minute rather than 
the month is displayed. 

mm Displays the month as a number with a leading zero (01-12). If the mm 
specifier immediately follows an h or hh specifier, the minute rather than 
the month is displayed. 

mmm Displays the month as an abbreviation (Jan-Dec) using the strings given 
by the ShortMonthNames global variable. 

mmmm Displays the month as a full name (January-December) using the strings 
given by the LongMonthNames global variable. 

yy Displays the year as a two-digit number (00-99). 

yyyy Displays the year as a four-digit number (0000-9999). 

h Displays the hour without a leading zero (0-23). 

hh Displays the hour with a leading zero (00-23). 
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n Displays the minute without a leading zero (0-59). 

nn Displays the minute with a leading zero (00-59). 

s Displays the second without a leading zero (0-59). 

ss Displays the second with a leading zero (00-59). 

z Displays the millisecond without a leading zero (0-999). 

zzz Displays the millisecond with a leading zero (000-999). 

t Displays the time using the format given by the ShortTimeFormat global 
variable. 

tt Displays the time using the format given by the LongTimeFormat global 
variable. 

am/pm Uses the 12-hour clock for the preceding h or hh specifier, and displays 
'am' for any hour before noon, and 'pm' for any hour after noon. The 
am/pm specifier can use lower, upper, or mixed case, and the result is 
displayed accordingly. 

a/p Uses the 12-hour clock for the preceding h or hh specifier, and displays 'a' 
for any hour before noon, and 'p' for any hour after noon. The a/p 
specifier can use lower, upper, or mixed case, and the result is displayed 
accordingly. 

ampm Uses the 12-hour clock for the preceding h or hh specifier, and displays 
the contents of the TimeAMString global variable for any hour before 
noon, and the contents of the TimePMString global variable for any hour 
after noon. 

/ Displays the date separator character given by the DateSeparator global 
variable. 

: Displays the time separator character given by the TimeSeparator global 
variable. 

'xx'/"xx" Characters enclosed in single or double quotes are displayed as-is, and do 
not affect formatting. 

SmartRoster Options 
You can set any of the general SmartRoster Options by selecting the File > 
Options  menu. 

The various sections are arranged in tabbed pages.  

The Organisation tab 

 

 

 

 

 

If you have not 
registered you can 
do so by clicking 
this button 

When you 
register, your 
registered name 
appears here 

This shows 
how many 
licences you 
have 
registered 

For trial 
(unregistered) 
users this shows 
how many days 
left on the current 
trial 

Activate 
Auto Web 
Update by 
ticking this 
box 

The name you enter 
here will appear on 
all reports 
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The Open and Save tab 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Import tab 

The import tab is where you specify a file to be automatically imported. See 
pages 50 and 53 for further details. 

 

Tick “Open 
Recent” to have 
the most recently 
edited file opened 
whenever you start 
up Smart-Schedule 

If you tick Autosave, your work 
will be saved automatically at 
regular intervals 

This is how often 
your work will be 
saved if Autosave 
is ticked 

For security you can 
save your file in an 
encrypted format. 
This means that 
only those who 
know the password 
will be able to open 
the file. After ticking 
the box you enter a 
password in the 
“Password” box. 

Ticking “remind to back up” will cause a small 
reminder dialog to show every time you close 
SmartRoster. This provides a simple reminder to 
backup and does the backup for you. (You’ll need 
a flash or thumb  drive or something similar) 

Ticking “Enable file sharing” will turn on 
file sharing for the current SmartRoster 
file. This helps prevent one user over-
writing changes by another user. It is 
only available for multiple licenses 
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The Auto Fill tab 

 

Look-back days 

The Look-back period is the days that the automatic scheduler will consider prior 
to the start date of the scheduling period. The automatic scheduler will take prior 
allocations into account when allocating roles for the current period.  

Enter the number of prior days to consider in the Look-back Days edit box. You 
can decide whether or not to make these visible in the Schedules panel by ticking 
the Make Visible check box. Note: Even if they are visible, the automatic 
scheduler will not allocate look-back days. 

Global Enforced Break 

Entering a number in Global Enforced Break will cause the automatic scheduler 
to enforce a non-scheduled break of the specified minutes, hours, or days 
between all timeslots for each person in the schedule. To specify individual 
breaks see page 44. 

Non-Usage Target settings 

Weight allocation by the events a person can serve.  

When AutoFill starts building schedules it first must calculate a target for all role 
members who do not have a usage target specified. AutoFill can do this in two 
ways.  

If you TICK this option, then for each active role/event pair it finds every role 
member that can service in that event and evenly allocates the un-allocated 
timeslots between them. This means that people who are available for more 
events will tend to have a higher target overall.  

If you UN-tick this option AutoFill calculates the TOTAL unscheduled slots across 
ALL events for each role and allocates them evenly between all role members 
who do not have a usage target specified. Then for each of these role members 
it re-allocates their timeslots between each of the events for which they are 
available. This option generates targets that are NOT weighted by the events a 
role member is available to serve. 
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Some users will consider that it is fairer to give more time to those people who 
are more available or less restricted in events they can serve. Other users will 
want to have every person scheduled about the same number of times even if 
they are more or less available. 

Cannot exceed calculated role member target by more than...  

AutoFill will generally NOT exceed usage targets (those explicitly specified). What 
about the targets that are generated for non-fixed role members? This option 
allows you to indicate the tolerance for exceeding target for non-fixed members.  

Make this a large number to effectively say "I don't care how many times you 
use a non-fixed role member - just fill as many timeslots as possible". Setting a 
small number (say 0 or 1) will possibly increase the number of unfilled slots, but 
at least you know that no person will be scheduled much more than any other 
non-fixed role member.  

For a description of the “Role Order” and” Advanced...” settings, see pages 78, 
78. 

The Email tab 

Before you can use the email facility you must enter at least the Email account 
and the Host name. See page 100 for a list of email settings. 

The Report tab 

This tab has only one option: 

� Use Acrobat Reader as report viewer  

If you tick this box, SmartRoster will use the Adobe's Acrobat Reader product to 
preview and print reports.  

� Enable Report Uploading via FTP 

If you tick this box, SmartRoster will allow you to upload any report from within 
the SmartRoster report viewer to a web site in pdf format. This is only useful if 
you have a web site (such as your Church or organisation's web site) and have 
FTP user and password to access your web site. If you are not sure then contact 
your Church or organisation's webmaster, or contact your web site's Hosting ISP 
and request your FTP user id and password. 

Web address:  your FTP server name, e.g:   www.MyChurch.org 

User ID:  the FTP logon user ID provided by your ISP or webmaster  

Password: the FTP logon password provided by your ISP or webmaster 

Port: defaults to 21 but you can specify any port to use 

Server path:  the server path to which you will be initially connected. Your 
files will be uploaded into this path. Eg:  /httpdocs/schedule 

The “Attendance status” tab 

Enter your attendance status flags in the list box provided, one per line. See 
page 94. 

The “Custom Fields” tab 

Create and use custom personnel fields. You can now create and use your own 
fields for personnel. These fields allow you to store any kind of textual or 
numeric information that is not possible by other methods. See page 53 for 
further help on using custom fields. 
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The "Other" tab 

This tab has the following options: 

� Enforce associations when manually scheduling 

Tick this option to enable this feature.  If ticked then when you manually 
schedule a person who has keep-together associations with another person or 
persons then these other people will also be automatically scheduled in the same 
event occurrence. 

� Show Welcome dialog on start up.  

The Welcome dialog shows every time you start SmartRoster. If you do not want 
it to show just remove the tick from the box. 

� Show “New File” wizard on new files  

The New File wizard shows whenever you create a new file. If you cancel it you 
can re-activate it at any time by selecting the "Help | Setting up a new file" 
menu. 

� Show “New File” wizard on new files  

Untick this (ticked is the default) to go back to the Windows 2000/NT look-and-
feel 

Costing 

If you have purchased an “Unlimited Persons” or Commercial license, then this 
option is available. By enabling costing, you will be able to define various costs 
per person, role, event, role-member and then report on these using the Analysis 
reports.  

Default rate: will apply to any person who does not have a rate set and where a 
rate cannot be found from related role or event. 

 


